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About this Guide

The User Guide provides conceptual information about the NetIQ Directory and Resource 
Administrator (DRA) product. This book defines terminology and various related concepts.

Intended Audience
This book provides information for individuals responsible for understanding administration 
concepts and implementing a secure, distributed administration model.

Additional Documentation
This guide is part of the Directory and Resource Administrator documentation set. For the most 
recent version of this guide and other DRA documentation resources, visit the DRA Documentation 
website (https://www.netiq.com/documentation/directory-and-resource-administrator/
index.html). 

Contact Information
We want to hear your comments and suggestions about this book and the other documentation 
included with this product. You can use the comment on this topic link at the bottom of each page of 
the online documentation, or send an email to Documentation-Feedback@microfocus.com.

For specific product issues, contact Micro Focus Customer Care at https://www.microfocus.com/
support-and-services/.
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1 1Getting Started

Before you begin managing Active Directory objects using the NetIQ Directory and Resource 
Administrator™ (DRA) you should understand the basic tenets of what DRA will do for your 
enterprise and the role of DRA components in the product architecture. 

What is Directory and Resource Administrator
NetIQ Directory and Resource Administrator delivers secure and efficient privileged-identity 
administration of Microsoft Active Directory (AD). DRA performs granular delegation of “least 
privilege” so that administrators and users receive just the permissions needed to complete their 
specific responsibilities. DRA also enforces adherence to policy, provides detailed-activity auditing 
and reporting, and simplifies repetitive task completion with IT process automation. Each of these 
capabilities contributes to protecting your customers’ AD and Exchange environments from the risk 
of privilege escalation, errors, malicious activity, and regulatory non-compliance, while reducing 
administrator burden by granting self-service capabilities to users, business managers, and Help 
Desk personnel.

DRA also extends the powerful features of Microsoft Exchange to provide seamless management of 
Exchange objects. Through a single, common user interface, DRA delivers policy-based 
administration for the management of mailboxes, public folders, and distribution lists across your 
Microsoft Exchange environment.

DRA provides the solutions you need to control and manage your Active Directory, Microsoft 
Windows, Microsoft Exchange, and Azure Active Directory environments.

 Support for Azure and on-premises Active Directory, Exchange, and Skype for Business: 

Delivers administrative management of Azure and on-premises Active Directory, on-premises 
Exchange Server, on-premises Skype for Business, Exchange Online, and Skype for Business 
Online.

 Granular user and administrative privilege-access controls: Patented ActiveView technology 
delegates just the privileges needed to complete specific responsibilities and protect against 
privilege escalation.

 Customizable web console: Intuitive approach enables non-technical personnel to easily and 
safely perform administrative tasks via limited (and assigned) capabilities and access.

 In-depth activity auditing and reporting: Provides a comprehensive audit record of all activity 
performed with the product. Securely stores long-term data and demonstrates to auditors (e.g. 
PCI DSS, FISMA, HIPAA and NERC CIP) that processes are in place for controlling access to AD. 

 IT Process Automation: Automates workflows for a variety of tasks, like provisioning and 
deprovisioning, user and mailbox actions, policy enforcement, and controlled self-service tasks; 
increases business efficiencies, and reduces manual and repetitive administrative efforts.

 Operational integrity: Prevents malicious or incorrect changes that affect the performance and 
availability of systems and services by providing granular access control for administrators and 
managing access to systems and resources.
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 Process enforcement:  Maintains the integrity of key change management processes that help 
you improve productivity, reduce errors, save time, and increase administration efficiency.

 Integration with Change Guardian: Enhances auditing for events generated in Active Directory 
outside of DRA and workflow automation.

Understanding Directory and Administrator Components
The components of DRA that are consistently used to manage privileged access include primary and 
secondary servers, administrator consoles, reporting components, and the Workflow Engine to 
automate workflow processes. 

The following table identifies the typical user interfaces and Administration servers used by each 
type of DRA user:

DRA Administration Server
The DRA Administration server stores configuration data (environmental, delegated access, and 
policy), executes operator and automation tasks, and audits system wide activity. While supporting 
several console and API level clients, the server is designed to provide high availability for both 
redundancy and geographic isolation through a Multi-Master Set (MMS) scale-out model. In this 
model, every DRA environment will require one primary DRA Administration server that will 
synchronize with a number of additional secondary DRA Administration servers.

We strongly recommend that you do not install Administration servers on Active Directory domain 
controllers. For each domain that DRA manages, ensure there is at least one domain controller in the 
same site as the Administration server. By default, the Administration server accesses the closest 
domain controller for all read and write operations; when performing site-specific tasks, such as 
password resets, you can specify a site specific domain controller to process the operation. As a best 
practice, consider dedicating a secondary Administration server for your reporting, batch processing, 
and automated workloads.

Type of DRA User User Interfaces Administration Server

DRA Administrator

(The person who will 
maintain the product 
configuration)

Delegation and Configuration Console Primary server

Advance Administrator DRA Reporting 

PowerShell

CLI

DRA ADSI Provider

Any DRA server

Help Desk Occasional 
Administrator

Account and Resource Management 
node in the Delegation and 
Configuration Console

Web Console

Any DRA server
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Account and Resource Management
Account and Resource Management is a node in the Delegation and Configuration Console for DRA 
assistant administrators to view and manage delegated objects of connected domains and services.

Web Console
The Web Console is a web-based user interface that provides quick and easy access to DRA assistant 
administrators to view and manage delegated objects of connected domains and services. 

Administrators can customize the look and use of the Web Console to include customized enterprise 
branding and customized object properties, as well as configure integration with Change Guardian 
servers to enable change auditing that occurs outside of DRA.

The DRA Administrator can also create and modify automated workflow forms to run routine 
automated tasks when triggered.

Unified Change History is another feature of the Web Console that enables integration with Change 
History servers to audit changes made to AD objects outside of DRA. Change History report options 
include the following:

 Changes made to...
 Changes made by...
 Mailbox created by...
 User, group, and contact email address created by...
 User, group, and contact email address deleted by...
 Virtual attribute created by...
 Objects moved by...

Reporting Components
DRA Reporting provides built-in, customizable templates for DRA management and details of DRA 
managed domains and systems:

 Resources reports for AD objects
 AD object data reports
 AD summary reports
 DRA configuration reports
 Exchange configuration reports
 Office 365 Exchange Online reports
 Detailed activity trends reports (By month, domain, and peak)
 Summarized DRA activity reports

DRA reports can be scheduled and published through SQL Server Reporting Services for convenient 
distribution to stakeholders.
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Workflow Engine
DRA integrates with the Workflow Engine to automate workflow tasks via the Web Console where 
assistant administrators can configure the Workflow Server and execute customized workflow 
automation forms, and then view the status of those workflows. For more information about the 
Workflow Engine, see Workflow Automation documentation on the DRA Documentation site.
10 Getting Started
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Product Architecture
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2 2Working with the User Interfaces

DRA user interfaces address a variety of administration needs. These interfaces include:

Web Console 
Enables you to perform common account and resource administration tasks through a Web-
based interface. You can access the Web Console from any computer running Internet Explorer, 
Chrome, or Firefox.

PowerShell 
The PowerShell module allows non-DRA clients to request DRA operations using PowerShell 
cmdlets.

NetIQ Reporting Center Console 
Enables you to view and deploy Management reports so you can audit your enterprise security 
and track administration activities. Management reports include activity reports, configuration 
reports, and summarization reports. Many of these reports can be viewed in a graphical 
representation.

Web Console
The Web Console is a Web-based user interface that provides quick and easy access to many user 
account, group, computer, resource, and Microsoft Exchange mailbox tasks. You can customize 
object properties to increase efficiency of routine tasks. You can also manage general properties of 
your own user account, such as the street address or cell phone number.

The Web Console displays a task only if you have the power to perform that task.

 “Starting the Web Console” on page 13
 “Configuring the Web Console” on page 14
 “Customizing the Web Console” on page 17
 “Managing Objects in the Web Console” on page 19
 “Generating Change History Reports” on page 19
 “Using Workflow Automation” on page 21

Starting the Web Console
You can start the Web Console from any computer running Internet Explorer. To start the Web 
Console, specify the appropriate URL in your Web browser address field. For example, if you 
installed the Web component on the HOUserver computer, type https://
HOUserver.entDomain.com/draclient in the address field of your Web browser. 

NOTE: To display the most current account and Microsoft Exchange information in the Web Console, 
set your Web browser to check for newer versions of cached pages at every visit.
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Configuring the Web Console
If you have DRA Administration powers, you can configure Advanced Authentication, client branding 
and session settings, and all the required server connections for the Web Console. To access any of 
these settings, log in to the Web Console and navigate to Administration > Configuration. 

NOTE: The Administration tab in the masthead will not display if you do not have the required 
administrative powers.

Advanced Authentication
Advanced Authentication lets you move beyond a simple user name and password to a more secure 
way of protecting sensitive information by using multi-factor authentication. Multi-factor 
authentication is a method of computer access control that requires more than one method of 
authentication from separate categories of credentials to verify a user's identity.

After the DRA Administrator configures chains and events, if you have the required powers, you can 
log into the Web Console and enable Advanced Authentication. Once authentication is enabled, 
every user will be required to authenticate through Advanced Authentication before being given 
access to the Web Console.

To enable Advanced Authentication, select Advanced Authentication from the Configuration tab, 
click Enable Advanced Authentication, and configure the form according to the instructions provided 
for each field.

For more information about Advanced Authentication, see “Authentication” in the DRA 
Administrator Guide.

Web Console Branding
You can customize the login screen and the masthead of the DRA Web Console, as follows: 

 Masthead: This is the high-level navigation bar at the top of the Web Console after logging in.
 Logo image or alternate text: Displays on the far left of the masthead bar. You can display a 

logo image or alternate text, but not both.
 Masthead color: Overlays the entire masthead with this color, except for the logo image 

area.
 Themed login screen: How the login page appears when accessing the Web Console URL in your 

browser. The DRA theme is configured and enabled by default.
 Logo image or alternate text: Displays above the product title and credential fields. You can 

display a logo image or alternate text, but not both.
 Application title: Displays between the credential fields and logo image.
 Notification modal: This is a message box that overlays and obscures the login page until 

the user clicks OK. It is typically used to inform the user that access to the console implies 
consent to follow a company security policy. Once enabled, all users who access the Web 
Console will get the prompt.
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Configure the Masthead
To configure the masthead:

1 Log in to Web Console, and navigate to Administration > Configuration > Branding.
2 Do one of the following. If you add both text and an image file, only the image will be displayed. 

 Update the Logo Image: 
1. Add the saved image file name, including the file extension in the Logo Image field of 

the Masthead tile.
2. Save the logo image in the “assets” directory on the web server. For example:

C:\inetpub\wwwroot\DRAClient\assets 
The optimal image size is 56x56 pixels.

 Type or overwrite existing text in the Image Alternate Text field of the Masthead tile, as 
required.

3 Click Save at the bottom of the page to complete the configuration changes.

Configure the Login Screen
The procedure below provides information for modifying all three configurable options, the 
company logo, application title, and notification modal. You can modify one, two, or all three of 
these options.

To change the default theme in the Login screen:

1 Save your company logo in the “assets” folder on the web server. For example:
C:\inetpub\wwwroot\DRAClient\assets 
The optimal image size is 115x28 pixels.

2 Log in to Web Console, and navigate to Administration > Configuration > Branding.
3 Replace the file name in the Company Logo Image field of the Login tile with the name of the 

saved image file, including the file extension.
4 Modify the text in the Application Title field, as applicable.
5 Click Show a notification modal at login to enable this setting, and type a title for the notification 

prompt. Type or paste the content of the message you want the users to see in the Content 
field. For example:
You are logging into a secure network. By logging into this system you consent to abide by the 
company's security policies for network access.

6 Select the style for the message. The style changes the image flag that is attached to the 
message box (shown below). If desired, you can click Preview to see how the message will be 
displayed.
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7 Click Save at the bottom of the page to complete the configuration changes.

Client Session Settings
In Client Session Settings, you can define a time increment for the Web Console to log out 
automatically after inactivity or set it to never log out automatically. 

To configure Auto Logout in the Web Console, navigate to Administration > Configuration > Client 
Session Settings. Enable the automatic logout feature with the toggle switch and if needed, modify 
the setting for the inactivity duration, in minutes.

Server Connections
When accessing the login page for the Web Console in your browser, there are Options settings that 
you can configure to define how you connect to DRA. These settings are also located via the Server 
Connection option in the user profile menu of the Web Console. The service ports for the REST 
Server and the DRA Server have default settings of 8775 and 11192, respectively. You can set new 
defaults for these in the Server Connections configuration or update them from the profile or login 
screen Options when no default is enabled. The connection settings for the Server Connection 
configuration are retained with your Windows user profile. 

Information about the settings you can modify from the Server Connection configuration, either 
from the Options menu on the login screen or the user profile menu after logging in, are provided 
below:

 Information  Error

 Warning  Question

REST Server Settings Description

Use automatic discovery Finds a REST server automatically; no configuration 
options are available

Connect to the default REST Server

(Only displayed if the default is enabled in the Server 
Connections configuration)

Uses the default setting from the Server Connections 
configuration (when enabled); no configuration 
options are available

Connect to a specific REST server The user configures the server and port

Connect to a REST server in a specific domain The user provides a managed domain and chooses a 
connection option:

 Use automatic discovery (in the domain 
provided)

 Primary server for this domain
 Search for a REST server (in the domain 

provided)
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If desired, you can configure a default location, server and domain, for the REST Server, the DRA 
Server, or both, from the Server Connections configuration in the Web Console.

To enable default settings, log in to the Web Console and navigate to Administration > Configuration 
> Server Connections. Enable the connection settings that you want use and click Save.

REST Server Connection
The configuration for the REST Service connection includes setting a default server location, 
modifying the port (if needed), and a connection timeout, in seconds. You can also disable both 
settings with the toggle switch.

When providing the REST Server location, use the format shown in the example below:

ServerName.DomainName.com

DRA Server Connection
The configuration for the DRA Service connection includes setting a default server location and 
modifying the port (if needed). You can also disable the setting with the toggle switch.

When providing the DRA Server location, use the format shown in the example below:

ServerName.DomainName.com

Customizing the Web Console
You can customize object properties in the Web Console. When implemented correctly, property 
customizations will help to automate tasks with object management. 

DRA Server Settings Description

Use automatic discovery Finds a DRA server automatically; no configuration 
options are available

Connect to the default DRA Server

(Only displayed if the default is enabled in the Server 
Connections configuration)

Uses the default setting from the Server Connections 
configuration (when enabled); no configuration 
options are available

Connect to a specific DRA server The user configures the server and port

Connect to a DRA server in a specific domain The user provides a managed domain and chooses a 
connection option:

 Use automatic discovery (in the domain 
provided)

 Primary server for this domain
 Search for a DRA server (in the domain 

provided)
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Customizing Property Pages
If you have DRA Administration powers, you can customize the object property forms that you use in 
your Active Directory management role by object type. This includes creating and customizing new 
object pages that are based on object types that are built into DRA. You can also modify properties 
for the built-in object types.

Property objects are clearly defined in the Property Pages list in the Web Console so you can easily 
identify which object pages are built-in, which built-in pages are customized, and which pages are 
not built-in and were created by an administrator.

Customizing an Object Property Page
You can customize object property forms by adding or removing pages, by modifying existing pages 
and fields, and by creating custom handlers for property attributes. The custom handlers on a field 
are executed whenever that field's value is modified. The timing can be configured as well, so the 
administrator can specify if the handlers should be run immediately (on every key press), when the 
field loses focus, or after a specified time delay.

The object list in Property Pages provides operation types for each object type, Create Object and 
Edit Properties. These are the principal operations your assistant administrators perform in the Web 
Console. They perform these operations by navigating to Management > Search or Advanced Search. 
Here they can create objects from the Create pull-down menu or edit existing objects selected in the 
search results table through the Properties icon.

To customize an object property page in the Web Console:

1 Login to the Web Console with DRA Administration privileges.
2 Navigate to Administration > Customization > Property Pages.
3 Select an object and operation type (Create Object or Edit Object) in the Property Pages list.

4 Click the Properties icon .
5 Customize the object property form by doing one or more of the following, and then applying 

your changes:
 Add a new property page: + Add Page
 Reorder and delete property pages
 Select a property page and customize the page:

 Reorder configuration fields in the page: 

 Edit fields or subfields: 

 Add one or more fields:  or Insert a new Field

 Remove one or more fields: 
 Create custom handlers for properties by using scripts, message boxes, or queries (LDAP, 

DRA, or REST)
For more information about using custom handlers, see “Adding Custom Handlers”, in the 
DRA Administrator Guide.
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Creating a New Object Property Page
To create a new object property page:

1 Login to the Web Console with DRA Administration powers, and navigate to Administration > 
Customization > Property Pages, and click  Create.

2 Create the initial object properties form by defining its name, icon, object type, and operation 
configuration.
After clicking OK, Create actions are added to the Create drop-down menu while Property 
actions display in object form when the user selects and edits an object from the search list.

3 Customize the new form as required. See Customizing an Object Property Page.

Managing Objects in the Web Console
You manage objects in the Web Console by navigating to the Management masthead. From here, 
you can search by object type for objects in domains, containers, and the Recycle Bin. With a 
domain, container, or OU selected, you can also create new objects, add and remove members from 
groups, and move objects.

If you select an object in the search results list, all applicable actions that you can take on that object 
are available on the taskbar above the grid. The options available are based on the object type 
selected, the components currently configured for DRA, and your assigned administrator privileges.

To edit an object’s properties, mouse over the object and click the Properties icon  that appears 
on the object row. From here, you can access all the object’s Properties pages in the left navigation 
pane. 

IMPORTANT: If you want to protect an object from accidental deletion, scroll to the bottom of the 
General Properties page, select the check box to enable this feature, and Apply the changes.

For more information about actions you can take on objects, see the following topics:

 Managing User Accounts, Groups, and Contacts
 Managing Exchange Mailboxes and Public Folders
 Managing Resources

Generating Change History Reports
If Change History is configured by your DRA Administrator and you have the Generate UI Reports 
power. You can generate change history reports for managed objects in DRA. This includes changes 
made in DRA and outside of DRA. You can only generate change history reports from the Web 
Console. 

To generate Unified Change History (UCH) reports:

1 Launch the Web Console.
2 Go to Management > Search.
3 Define the search criteria using the Search by, search term, and Filters options. 
4 Click the Search button to display the search results.
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5 Select the objects for which you want to generate reports.

6 Click the View Change History Reports icon .
In the Unified Change History Report form, you can edit and generate your report criteria from 
the Type, Target object(s), and Filters options, to include defining the servers where the changes 
are detected (DRA and Change Guardian).

7 Click Generate to fetch audit data and to generate a UCH report.
8 You can sort and export the report into a required format such as CSV and HTML.

Generate and Export a User’s Change History
You can use the Web Console to view and export a history of the changes made to or by a user, 
which includes the following types of reports:

 Changes made by the user
 Changes made to the user
 User mailboxes created by the user
 User mailboxes deleted by the user
 Group and contact email addresses established by the user
 Group and contact email addresses deleted by the user
 Virtual attributes created or disabled by the user
 Objects moved by the user

To view or generate the Change History report:

1 Start the Web Console.
2 Search for the user whose history you want to view.
3 Click the View Change History Reports icon.
4 Select the type of change required from the Type pull-down menu, and define the Filters 

criteria.
5 Click Generate.
6 To create a CSV file of the displayed report, you can export all of the changes generated or just 

those displayed on the current page, by executing one of the following options: 

 Click Export All  and save the exported report.

 Click Export Current Page  and save the exported report.
If needed, you change number of changes that show on the page, up to 200 items.
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Using Workflow Automation
Using Workflow Automation, you can automate IT processes by launching workflow forms that run 
on execution of a workflow or when triggered by a named workflow event that is created in the 
Workflow Automation server.

Workflow forms, when created or modified, are saved to the Web Server. When you log on to the 
Web Console for this server, you will have access to the forms based on delegated powers and how 
the forms are configured. Forms are generally available to all users with Web server credentials. The 
capability to submit the form requires appropriate powers.

Launching a workflow form: Workflows are created in the Workflow Automation Server, which must 
be integrated with DRA via the Web Console. In order to save a new form, you must have either the 
Launch Specific Workflow or Trigger Workflow by Event option configured in the form properties. 
More information about these options is provided below: 

 Launch Specific Workflow: This option lists all the available workflows that are in production in 
the Workflow Server for DRA. For the workflows to populate in this list, they need to be created 
in the DRA_Workflows folder in the Workflow Automation server.

 Trigger Workflow by Event: This option is used to execute workflows with pre-defined triggers. 
The workflows with triggers are also created in the Workflow Automation server. 

NOTE: Only workflow forms configured with Launch Specific Workflow will have an execution history 
that can be queried in the main search pane under Tasks > Requests.

More information about workflow automation is included in the DRA Administrator Guide.

Account and Resource Management
The Account and Resource Management node in the Delegation and Configuration Console provides 
access to most of the DRA assistant administrator tasks, addressing enterprise management needs 
from basic administration to advanced Help Desk issues. Using Account and Resource Management, 
you can perform account and resource management tasks and manage Microsoft Exchange 
mailboxes. 

Account and Resource Management contains the following nodes: 

All My Managed Objects 
Enables you to manage objects, such as user accounts, groups, contacts, resources, dynamic 
groups, dynamic distribution groups, resource mailboxes, and public folders for each domain in 
which you have some power.

Temporary Group Assignments 
Enables you to manage group memberships for users who only need group membership for a 
specific time period.

Advanced Search Queries 
Enables you to manage advanced queries available on the Administration server.
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Recycle Bin 
Enables you to manage deleted user accounts, groups, contacts, and resources, for any 
Microsoft Windows domain where the Recycle Bin is enabled.

To access the Account and Resource Management node, click Delegation and Configuration in the 
NetIQ Administrator program folder and expand the Delegation and Configuration node in the 
console.

When you start the Delegation and Configuration console, you initially connect to the best available 
Administration server in the local domain. The best-available Administration server is the closest 
server, which is typically a server in the network site. By seeking the best available Administration 
server, DRA provides a quicker connection and improved performance.

To learn more about working in Account and Resource Management, see the following topics:

 “Connecting to an Administration Server or Managed Domain” on page 22
 “Modifying the Console Title” on page 23
 “Customizing List Columns” on page 23
 “Managing Objects in Account and Resource Management” on page 24
 “Executing Saved Advanced Queries” on page 24
 “Restoring Console Settings” on page 25
 “Using Special Characters” on page 25
 “Using Wildcard Characters” on page 26
 “Viewing Your Assigned Powers and Roles” on page 27
 “Viewing the Product Version Number and Installed Hotfixes” on page 27
 “Viewing Your Current License” on page 27
 “Recovering a BitLocker Password” on page 28

Connecting to an Administration Server or Managed Domain
By default, DRA connects to the best available Administration server for a managed domain or 
computer. The best available Administration server is the closest server, which is typically a server in 
the network site. If the site does not include an Administration server, DRA connects to the next 
available server in the managed domain or managed subtree. You can also specify the 
Administration server or domain to which you want to connect.

When you first start the user interfaces, DRA initially connects to the domain of your logon account. 
If you are logged on to a domain that is not managed by an Administration server, or if DRA cannot 
connect to the Administration server for that domain, DRA may display an error message. Ensure the 
Administration server is available and try again.

To connect to an Administration server:

1 On the File menu, click Connect to DRA server.
2 Click Connect to this DRA server.
3 Type the name of the Administration server, using the following format: computername.
4 Click OK.
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To connect to a managed domain or computer:

1 On the File menu, click Connect to DRA server.
2 Select the appropriate option, and then type the name of the managed domain or computer. 
3 For example, to connect to the HOULAB domain, click Connect to a DRA server that manages this 

domain, and then type HOULAB. 
4 To specify an Administration server for the managed domain or computer, click Advanced, and 

then select the appropriate option.
5 Click OK.

Modifying the Console Title
You can modify the information displayed in the title bar of the Delegation and Configuration 
console. For convenience and clarity, you can add the user name with which the console was 
launched and the Administration server to which the console is connected. In complex environments 
in which you need to connect to multiple Administration servers using different credentials, this 
feature helps you quickly discern which console you need to use.

To modify the console title bar:

1 Start the Delegation and Configuration console.
2 Click View > Options.
3 Select the Window Title tab.
4 Specify the appropriate options, and then click OK.

Customizing List Columns
You can select which object properties DRA displays in list columns. This flexible feature enables you 
to customize the user interface, such as lists for search results, to better meet the specific demands 
of administrating your enterprise. For example, you can set columns to display the user logon name 
or group type, letting you quickly and effectively find and sort the data you need. 

To customize list columns:

1 Select the appropriate node. For example, to choose which columns display when viewing 
search results on managed objects, select All My Managed Objects.

2 On the View menu, click Choose Columns.
3 From the list of properties available for this node, select the object properties you want to 

show. 
4 To change the column order, select a column, and then click Move Up or Move Down.
5 To specify the column width, select a column, and then type the appropriate number of pixels in 

the provided field.
6 Click OK.
Working with the User Interfaces 23



Managing Objects in Account and Resource Management
You manage objects in Account and Resource Management by selecting All My Managed Objects or a 
sub-node in the directory tree. From here, you can search by object type for objects in domains, 
containers, and OUs. 

If you select an object in the search results list, all applicable actions that you can take on that object 
are available in the Tasks menu on the toolbar or in right-click menu. The options available are based 
on the object type selected, the components currently configured for DRA, and your assigned 
administrator privileges.

To edit an object’s properties, select the object and click Properties in the Tasks menu. From here, 
you can access all the object’s Properties pages by clicking page links in the left navigation pane. 

IMPORTANT: If you want to protect an object from accidental deletion, select the object and open 
Properties, select General in the navigation pane, select the check box to enable this feature, and 
Apply the changes.

For more information about actions you can take on objects, see the following topics:

 Managing User Accounts, Groups, and Contacts
 Managing Exchange Mailboxes and Public Folders
 Managing Resources

Executing Saved Advanced Queries
Using advanced queries, you can search for users, contacts, groups, computers, printers, OUs, and 
any other object that DRA supports. If you have the Execute Saved Advanced Queries power, you can 
execute advanced queries available in the Saved Queries list for any container in the Account and 
Resource Management node. For more information about your assigned powers, see Viewing Your 
Assigned Powers and Roles.

To execute saved advanced queries:

1 Expand Account and Resource Management > All My Managed Objects.
2 Select the appropriate container. For example, if you want DRA to search for user account 

information, select Users.
3 To view the advanced search pane, click Advanced Search.
4 In the advanced search pane, select an Advanced Search query from the Saved Queries list.
5 Click Load Query, and then click Find Now.
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Restoring Console Settings
DRA enables you to resize windows and then persists your window sizes. DRA also persists many 
other settings, including the last Administration server to which you connect, the columns you add 
or remove from list results, and column widths. If you want to restore these settings to the original 
setting with which you installed DRA, the Restore Default Settings option enables you to do so.

To restore default console settings:

1 Click View > Options.
2 Select the Saved Settings tab.
3 Review the information provided on the window, and then click Restore Default Settings. 

Using Special Characters
You cannot use the following special characters when naming user accounts, groups, contacts, OUs, 
computers, ActiveViews, AA groups, roles, policies, or automation triggers. These naming 
restrictions apply to the name of the object as well as the name of the rule that defines the object.

Naming user accounts, groups, and computers 
When specifying a pre-Windows 2000 name, you cannot use the following special characters:

IMPORTANT: For Public Folder Management the Backslash \ character is not supported.

When naming user accounts, groups, and computers in Microsoft Windows domains, you can use 
any special character. 

Naming contacts and OUs 
When naming contacts and OUs, you can use any special character.

Backslash \
Colon :
Comma ,
Double quote "
Equal sign =
Forward slash /
Greater than >
Left bracket [
Less than <
Plus sign +
Right bracket ]
Semi colon ;
Vertical bar |
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Naming ActiveViews, AA groups, and roles 
When naming ActiveViews, AA groups, and roles, you cannot use the backslash (\).

Naming policies and automation triggers 
When naming policies and automation triggers, you cannot use the backslash (\).

Invalid Characters in Azure 
Invalid characters will cause the synchronization between Azure Active Directory and your on-
premises directory to fail. See the "Directory object and attribute preparation" subtopic on the 
Microsoft Office support web site to learn more about these invalid characters.
To ensure that these characters are not used in your online mailbox properties, do the 
following:

1. Click the Configuration Management node in the Delegation and Configuration console, 
and select Update Administration Server Options. 

2. Click Azure Sync in the tab menu.
3. Click Enforce online mailbox policies for invalid characters and character length, and click OK.

Using Wildcard Characters
DRA supports wildcard characters in many fields in the DRA consoles and in CLI commands. 
Wildcards enable you to define rules that match multiple objects to a specific condition or standard, 
such as a naming convention. You can use wildcards instead of regular expressions to narrow or 
broaden the scope of the rule. Wildcard matching is not case-sensitive. You can also use the 
question mark (?), asterisk (*), or number sign (#) wildcard characters as normal characters by 
prefixing a backslash (\) to the particular wildcard character. For example, to search for abc*, type 
the search text abc\*.

DRA supports the following wildcard characters. You cannot use wildcard characters in names.

The following table provides examples of wildcard character specifications and what they match and 
do not match.

DRA does not support wildcard specifications that contain logical operations.

Match Item Character Definition

Any character Question mark ? Matches exactly one character

Any digit Number sign # Matches one digit

Any character, 0 or more matches Asterisk * Matches zero or more 
characters

Example Matches Does Not Match

Den??? Denton and Dennis Denison

El ????o El Campo and El Indio El Paso

Houston, TX ##### Houston, TX 77024 Houston, TX USOFA
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Viewing Your Assigned Powers and Roles
Roles and powers define how you manage objects. A role is a set of powers that provides the 
permissions required to perform a specific administration task, such as creating a user account or 
moving shared directories. 

The DRA Administrator assigns roles, adds you to specific AA groups, and associates you with 
ActiveViews (sets of domain objects you can manage). You can view these assignments through the 
Delegation and Configuration console. You do not need any auxiliary powers to view the roles and 
powers assigned to you.

To view your assigned powers and roles:

1 On the File menu, click DRA Properties.
2 Click Powers.
3 Select the appropriate view. For example, click Flat View to see a table of your AA group 

memberships, assigned powers and roles, and associated ActiveViews.
4 Expand the appropriate item. For example, under Has Power column, expand Roles and Powers 

to view the individual roles or powers assigned to you.
5 Click OK.

Viewing the Product Version Number and Installed Hotfixes
You can view the product version number and installed hotfixes from the DRA Properties window. 
This window provides version numbers and lists of installed hotfixes for the Administration server 
and the DRA client computer.

To view the product version number and installed hotfixes:

1 On the File menu, click DRA Properties.
2 Click General.
3 View the information you need.
4 Click OK.

Viewing Your Current License
DRA requires a license key file. You can view your product license from any Administration server 
computer. You do not need any auxiliary powers to view the product license.

To view your license:

1 On the File menu, click DRA Properties.
2 Click License.
3 Review the license properties, and then click OK.
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Recovering a BitLocker Password
Microsoft BitLocker stores its recovery passwords in Active Directory. With the required powers, you 
can use the DRA BitLocker Recovery feature to find and recover lost BitLocker passwords for end 
users. 

IMPORTANT: Before using the BitLocker Recovery Password feature, ensure that your computer is 
assigned to a domain and BitLocker is turned-on.

Viewing and Copying a BitLocker Recovery Password
If the BitLocker password for a computer is lost, it can be reset using the Recovery Password key 
from the computer's properties in Active Directory. Copy the password key and provide it to the end 
user.

To view and copy the recovery password:

1 Launch the Delegation and Configuration console and navigate to Account and Resource 
Management > All My Managed Objects.

2 Select the domain, and execute a search to list all computers in the domain.
3 In the computers list, right-click the required computer, and select Properties > BitLocker 

Recovery Password.
4 Right-click and copy the BitLocker recovery password, and paste the password text into a text 

file.

Finding a Recovery Password
If the name of a computer was changed, the Recovery Password must be searched for in the domain 
using the first eight characters of the Password ID.

To find a recovery password by using a password ID:

1 Launch the Delegation and Configuration console and navigate to Account and Resource 
Management > All My Managed Objects.

2 Right-click the Managed Domain, and then click Find BitLocker Recovery Password.
To find the first eight characters of the recovery password, see Viewing and Copying a BitLocker 
Recovery Password.

3 In the Find BitLocker Recovery Password page, paste the copied characters in the search field, 
and then click Search.
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DRA Reporting
DRA Reporting provides built-in, ready-to-use reports that let you quickly track duplicate accounts, 
last account logons, Microsoft Exchange mailbox details, and much more. Reporting also provides 
real-time details of changes made in your environment, including before and after values for 
changed properties. You can export, print, or view reports, or publish them to SQL Server Reporting 
Services. 

DRA provides two methods of generating reports that enable you to collect and review user account, 
group, and resource definitions in your domain: Activity Detail reports and DRA Management 
reports. Activity Detail reports, viewed through the Delegation and Configuration console, provide 
real-time change information for objects in your domain. For example, you can view a list of changes 
made to an object or by an object during a specified time period using Activity Detail reports. 

The following figure shows a sample Activity Detail report:

Optional DRA Management reports, viewed through the NetIQ Reporting Center (Reporting Center), 
provide activity, configuration, and summarization information about events in your managed 
domains. Some Management reports are available as graphical representations of the data. These 
built-in reports can also be customized to give you exactly the information you need.

For example, you can view a graph showing the number of events in each managed domain during a 
specified time period using Management reports. Reporting enables you to view details about the 
DRA security model, such as ActiveView and AA group definitions.

You must install and configure the optional Management reports before you can view these reports. 
For more information about installing reporting components, see the Installation Guide. For more 
information about DRA Reporting, see “DRA Reporting” on page 29.
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Start the Reporting Center Console in the NetIQ > Reporting Center program group.

The following figure shows the Reporting Center interface with DRA Management reports selected.

To learn more about DRA Reporting, see the following topics:

 “Understanding DRA Reporting” on page 30
 “How DRA Uses Log Archives” on page 31
 “Understanding Dates and Times” on page 32
 “DRA Reporting Tasks” on page 32

Understanding DRA Reporting
DRA Reporting provides two methods of generating reports that enable you to see the latest 
changes in your environment and to collect and review user account, group, and resource definitions 
in your domain.

Activity Detail reports  
Accessed through the Account and Resource Management node of the Delegation and 
Configuration console, these reports provide real-time change information for objects in your 
domain. 
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DRA Management reports 
Accessed through NetIQ Reporting Center (Reporting Center), these reports provide activity, 
configuration, and summarization information about events in your managed domains. Some 
reports are available as graphical representations of the data. 

For example, you can view a list of changes made to an object or by an object during a specified time 
period using Activity Detail reports. You can also view a graph showing the number of events in each 
managed domain during a specified time period using Management reports. Reporting also enables 
you to view details about the DRA security model, such as ActiveView and AA group definitions.

DRA disables functions and reports that your license does not support. You must also have the 
appropriate powers to run and view reports. Therefore, you may not have access to some reports.

DRA Management reports can be installed and configured as an optional feature and are viewed in 
Reporting Center. When you enable and configure data collection, DRA collects information about 
audited events and exports it to a SQL Server database on a schedule that you define. When you 
connect to this database in Reporting Center, you have access to over 60 built-in reports:

 Activity reports that show who did what, and when
 Configuration reports that show the state of AD or DRA at a specific point in time
 Summarization reports that show activity volume

For more information about configuring data collection for Management reports, see the 
Administrator Guide.

How DRA Uses Log Archives
In order to review and report on Assistant Administrator actions, DRA logs all user operations in the 
log archive on the Administration server computer. User operations include all attempts to change 
definitions, such as updating user accounts, deleting groups, or redefining ActiveViews. DRA also 
logs specific internal operations, such as Administration server initialization and related server 
information. In addition to logging these audit events, DRA logs the before and after values for the 
event so that you can see exactly what changed.

DRA uses a folder, NetIQLogArchiveData, called a log archive to securely store archived log data. DRA 
archives the logs over time and then deletes older data to make room for newer data through a 
process called grooming. 

DRA uses the audit events stored in the log archive files to display Activity Detail reports, such as 
showing what changes have been made to an object during a specified time period. You can also 
configure DRA to export information from these log archive files to a SQL Server database that NetIQ 
Reporting Center uses to display Management reports.

DRA always writes audit events to the log archive. You can enable or disable having DRA write events 
to the Windows event logs as well.

For more information about DRA auditing, see the Administrator Guide.
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Understanding Dates and Times
DRA uses the Short date style and Time style specified in the Regional Settings application in Control 
Panel for report display. DRA reports show UTC date and time as well as local date and time for 
events. DRA reports support the following date formats:

 m/d/yy
 m-d-yy
 m/d/yyyy
 m-d-yyyy
 mm/dd/yy
 mm-dd-yy
 mm/dd/yyyy
 mm-dd-yyyy
 dd/mm/yy
 dd-mm-yy
 dd/mm/yyyy

 dd-mm-yyyy

DRA Reporting Tasks
To generate DRA Management reports, install Reporting Center and enable data collection in DRA. 
For more information about enabling data collection, see the Administrator Guide. To generate 
Activity Detail reports, right-click over any object and click Reporting to see your choices for reports 
on that object. The following sections guide you through the various Reporting tasks.

Viewing Activity Detail Reports
Activity Detail reports display information about changes in your environment. You can view or print 
a report, as well as save a report in Excel, CSV, or TXT format. To view or print reports, you must be 
associated with the Reporting Administration role.

When viewing reports, enter criteria to specify the time period you want to display information 
about. You can also choose to view a report limited to changes made on specific DRA servers, and 
you can limit the number of rows to be included in the report. If the report size exceeds one of the 
following limits, DRA displays a message stating that the report is not complete: 

 Size exceeds 500 MB
 Time needed to query all DRA servers exceeds 5 minutes
 Number of rows to be displayed exceeds 1000

You have the option of viewing the report containing only the information retrieved before reaching 
one of these limits, or you can change the report criteria to view a report that meets these limits.

To view a report:

1 In the left pane, expand All My Managed Objects.
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2 To specify the object for which you want to view a report, complete the following steps:
2a If you know the object location, select the domain and OU that contains this object.
2b In the search pane, specify the object attributes, and then click Find Now.

3 In the list pane, right-click the object and click Reporting.
4 Select the type of report, such as Changes made to objectName or Changes made by 

objectName. The available reports vary depending on the type of object you have selected.
5 Select the start and end dates to specify the changes you want to view.
6 If you want to change the number of rows to be displayed, type a number over the default 

value of 250.

NOTE: The number of rows displayed applies to each Administration server in your 
environment. If you include 3 Administration servers in the report and use the default value of 
250 rows to display, up to 750 rows can be displayed in the report.

7 If you want to include only specific Administration servers in the report, select Restrict query 
to these DRA servers and type the server name or names you want the report to include. 
Separate multiple server names with commas.

8 Click OK.

NOTE: DRA might take up to 5 seconds to display recent changes in reports. Therefore, wait at 
least 5 seconds after making a change before you attempt to view a report that contains the 
change.

Exporting Activity Detail Reports
You can export Activity Detail reports in the following formats: XLS, CSV, and TXT. The default format 
is Microsoft Excel format.

To export Activity Detail reports:

1 In the report window, on the File menu, click Preview and Export.
2 In the Preview window, on the File menu, click Export Document > Excel File.
3 Select your export options and click OK.
4 In the Save as window, type a name for the file and click Save.

Printing Activity Detail Reports
To print reports, you must be associated with the Reporting Administration role. You can view or 
print Activity Detail reports, as well as save a report in various formats.

To print Activity Detail reports:

1 In the report window, on the File menu, click Preview and Export.
2 In the Preview window, on the File menu, click Print.
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Viewing Management Reports
You must install DRA Reporting and configure the DRA data collectors to be able to view 
Management reports in Reporting Center. For more information about installing DRA Reporting and 
configuring the DRA Collectors, see the Administrator Guide.

When you log on to the Reporting Center, the Web Service uses IIS to validate the account 
credentials according to the way you configured the Web Service during installation.

To view Management reports:

1 Log on to the computer that is running the Reporting Center Console.
2 Start Reporting Center Console in the NetIQ > Reporting Center program group.
3 Provide the required information in the Logon dialog box and click Logon.
4 In the Navigation pane, expand Reports > DRA Management Reports. 
5 Expand the report categories until you find a report you want to view.
6 Click the report name in the Navigation pane and the report will load in the center Results pane, 

displaying cached data.
7 If you want to see the report using the latest data, click Execute Report in the Results Pane.

You can change the default context settings to display different report results. For more information 
about context settings in Reporting Center, see the Administrator Guide.

Customizing Management Reports
More than 60 Management reports are shipped with DRA. Reporting Center gives you the flexibility 
to customize and deploy these reports in many ways. For more information about customizing and 
deploying Management reports in Reporting Center, see the Administrator Guide.

To customize a Management report:

1 View a report that is similar to a report you want to create. For more information, see Viewing 
Management Reports.

2 Customize the report by changing the report properties and context settings to display the 
information you want.

3 Click Execute Report.
4 On the Report menu, click Save Report As and specify a report title and location to save the new 

report.
5 Click Save.

For more information about working with Management reports in Reporting Center, see the 
Administrator Guide.
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3 3Searching for Objects

This chapter contains conceptual and procedural information about the Search and LDAP Search 
functionalities.

Search
DRA enables you to search for objects in on-premise Active Directory domains, Microsoft Exchange, 
and Azure tenants. You can search for users and groups in your Azure tenants, objects such as users, 
groups, contacts, computers, printers, and OUs in your Active Directory domains, and objects such as 
room mailboxes, equipment mailboxes, shared mailboxes, and dynamic distribution groups in 
Exchange. You can use the search filters for more efficient and effective searches.

NOTE: To get an accurate return of searched objects when using filters, any changes made to the 
pagination should be made before applying the filters and executing the search. Changing the items 
per page setting at the bottom of the Web Console when object type filters are applied is not 
supported. 

To access the search feature in the Web Console, navigate to Management > Search.

Using Wild Characters
DRA supports wildcard characters such as the question mark (?), asterisk (*), or number sign (#) to 
maximize your search results. Wildcard matching is not case-sensitive.

The following table provides examples of wildcard character specifications and what they match and 
do not match.

Multi-Field Searching
The Multi-Field Match option enables you to search for matches to multiple attributes with a single 
search. When you search using Multi-Field Match, your search string is compared to multiple 
attributes such as name, display name, first name, and last name and if the search string matches 
any of these attributes, the object is returned in the search results.

The Multi-Field Match option only supports the “begins with” search criteria. 

Character Match Item

Question mark ? Any one character or one digit

Number sign # Any one digit

Asterisk * Any number of characters or digits
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For example, if you have two users, one whose display name is “Martin Smith” and the other user 
whose user principal name is martha.jones@acme.com, and if you perform a search using the 
string “Mart” both users would be returned in the search results.

The table below lists the attributes that are searched for each object type:

NOTE: The multi-match feature is not supported on Object Selector searches in the Delegation and 
Configuration console when adding delegates or permissions for the Exchange objects listed below: 

 user mailbox
 mail-enabled user
 mail-enabled group
 mail-enabled contact
 dynamic distribution group
 shared mailbox 
 resource mailbox

Adding and Sorting Columns
You can sort the search result objects by any of the following attributes when you click an attribute's 
column header:

 Alias 
 Display Name
 Email
 EmployeeID
 First Name

Object Type Attributes Searched

Azure Group displayName, mail

Azure User displayName, employeeId, givenName, mail, 
surname, userPrincipalName

Computer displayName, name, sAMAccountName 

Contact displayName, employeeId, givenName, mail, 
mailNickname, name, surname

Dynamic Distribution Group displayName, mail, mailNickname, name

Group displayName, mail, mailNickname, name, 
sAMAccountName

Organizational Unit name

Recycle Bin name, sAMAccountName

User displayName, employeeId, givenName, mail, 
mailNickname, name, sAMAccountName, surname
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 Last Name
 Location
 Name
 Pre-Windows 2000 Name
 User Principal Name

To add or remove attribute columns, click the column icon.

Exporting Search Results
DRA enables assistant administrators to export Search results to a CSV file. To export the Search 
results from the Web Console, go to Management > Search and click the Download icon.

NOTE: Only the selected columns are exported. If you want additional data, not currently displayed, 
add those columns first and then export the Search results.

Advanced Search
DRA enables you to perform LDAP and virtual attribute queries in your on-premise Active Directory 
domains from the Advanced Search page. You can search using an existing query, modify an existing 
query, create a new query, and save new and modified queries for future use as public or private 
queries. Use the search filters for more efficient and effective searches.

To access the Advance Search queries feature in the Web Console, navigate to Management > 
Advanced Search.

Advance Search Queries
DRA supports both virtual attribute and LDAP queries to search for DRA and Active Directory objects. 
Virtual attributes can be associated with Active Directory object types such as users, groups, 
dynamic distribution groups, contacts, computers, and OUs. With a virtual attribute query you can 
filter the results returned from the LDAP query to return only those results that match the virtual 
attribute query. The virtual attribute query strings must begin with (objectCategory=<object 
type>). To perform a virtual attribute query, you must specify strings for both LDAP and virtual 
attribute queries.

LDAP query examples:
 To search for “all computer objects” in DRA: 

LDAP Query: (objectCategory=computer)
 To search for user objects with description "East\West Sales" in DRA: 

LDAP Query: (&(objectCategory=user)(description=East\5CWest Sales))
 To search for “all computer objects” in DRA: 

LDAP Query: (objectCategory=computer)
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IMPORTANT: The backslash character must be escaped in LDAP filters. Substitute \5C.

 To “list all disabled user objects” in DRA: 
LDAP Query: 
(&(objectCategory=person)(objectClass=user)(userAccountControl:1.2.840
.113556.1.4.803:=2))
The string 1.2.840.113556.1.4.803 specifies LDAP_MATCHING_RULE_BIT_AND. This 
specifies a bitwise AND of a flag attribute (an integer), such as userAccountControl, groupType, 
or systemFlags, and a bit mask (like 2, 32, or 65536). The clause is True if the bitwise AND of the 
attribute value and the bit mask is non-zero, indicating the bit is set.

Virtual Attribute query examples:
 To find all users whose company name is ABC: 

Query: (&(objectCategory=User)(CompanyName=ABC))
The DRA object is “User” and the virtual attribute is “CompanyName” (associated with user).

 To find all users with the company name ABC in the Storage domain: 
Query: (&(objectCategory=User)(CompanyName=ABC)(Domain=Storage))
The DRA object is “User” and the virtual attributes are “CompanyName” and “Domain” 
(associated with user)

 To find all groups with the product name DRA or all users with the company name ABC: 
Query: 
(|(&(objectCategory=Group)(ProductGroupName=DRA))(&(objectCategory=Use
r)(CompanyName=ABC)))
The DRA objects are “Group” and “User” and the virtual attributes are CompanyName 
(associated with user), ProductGroupName (associated with group).

 To find all groups whose product name is DRA or all users with the company name ABC in the 
Storage domain: 
Query: 
(|(&(objectCategory=Group)(ProductGroupName=DRA))(&(objectCategory=Use
r)(CompanyName=ABC)(Domain=Storage)))
The DRA objects are “Group” and “User” and the virtual attributes are CompanyName 
(associated with user), ProductGroupName (associated with group), Domain (associated with 
user.

Managing Advanced Queries
DRA uses LDAP to support the Advanced Search queries feature. Using advanced queries, you can 
search for users, contacts, groups, computers, OUs, and any other object that DRA supports. If you 
have the Execute Saved Advanced Queries power, you can execute advanced queries that are 
available in the My Searches and Public Searches lists for any container.

In addition to executing a search with a saved advanced query and viewing its details, with the 
applicable permissions, you can also do the following with advanced queries from the Advanced 
Search page:
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Create a new query 
Create an advanced query on either the primary Administration server or the secondary 
Administration server by providing the query string (LDAP and, if applicable, virtual attribute) 
for the new advanced query. After executing the search, expand the Search drop-down menu to 
save the query to either the My Searches list or the Public Searches list.

Modify a query 
Select an existing advanced query under My Searches or Public Searches and use the Modify 
option to change any of the search criteria. Once you execute the search with the updated 
search criteria, if desired you can expand the Search drop-down menu and select Save to save 
the changes to that query.

Copy a query 
Select an existing advanced query under My Searches or Public Searches and execute the 
search. After executing the search, you can expand the Search drop-down menu and select Save 
As to save the query with a different name.

Customize query results 
DRA provides you with a default set of columns in the search results list. To customize your 
search results from either a saved or unsaved query, click the Add/Remove Columns icon  on 
the right side of the page to change how the search results are displayed. 

Delete a query 
You can delete any advanced query that is in the My Searches list. With applicable permissions, 
you can also delete advanced queries in the Public Searches list. To delete a saved advance 
query, select it in the applicable list, and click Delete in the Search drop-down menu.

Clear a query 
In the Web Console, you can clear the form fields of a saved or unsaved query to make changes 
from a clean form. To clear the fields in a query, select Clear in the Search drop-down menu.

Exporting Advanced Search Results
DRA enables assistant administrators to export Advanced Search results to a CSV file. To export the 
Advanced Search results from the Web Console, go to Management > Advanced Search and click the 
Download icon.

NOTE: Only the selected columns are exported. If you want additional data, not currently displayed, 
add those columns first and then export the Advanced Search results.
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4 4Managing User Accounts, Groups, and 
Contacts

This chapter contains conceptual and procedural information for managing user accounts, groups, 
dynamic groups, dynamic distribution groups, and contacts in both the Account and Resource 
Management node of the Delegation and Configuration console and in the Web Console. The 
information for User accounts is more comprehensive to provide an example of how you manage 
objects in general in both of the client applications.

Managing User Accounts
Microsoft Windows relies on the user account type to determine access permissions for the 
associated user account. A user account can be global or local. DRA also supports InetOrgPerson 
objects, but recognizes InetOrgPerson objects as normal users.

Global user account 
A user account that can be used in any domain that trusts the domain in which the user account 
was created. You can grant specific permissions to a user account. You can also make a user 
account a member of a group and then assign permissions to that group. Grouping user 
accounts helps simplify the process of managing network permissions for many user accounts. 

Local user account 
A local user account is the same as any account that you use to log into a Windows operating 
system. It enables you to access the system's resources in your own user space.

To learn more about managing user accounts, see the following topics:

 “User Accounts in Trusted Domains” on page 41
 “User Account Management Tasks” on page 42
 “Transforming User Accounts” on page 44

User Accounts in Trusted Domains
Microsoft Windows stores user account and group definitions in the directory of the managed 
domain. Therefore, an Administration server cannot modify the directory information from a trusted 
domain unless that domain is also managed by DRA.

For example, in Account and Resource Management, you may see user accounts and groups that you 
cannot modify. These user accounts and groups are defined in domains trusted by one of the 
managed domains. However, you can add accounts and groups from a trusted domain to other 
groups in the managed domain.
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User Account Management Tasks
This section guides you through administering user accounts in the Account and Resource 
Management node of the Delegation and Configuration Console and in the Web Console. With the 
appropriate powers, you can perform various user account management tasks, such as creating and 
deleting accounts. If you select multiple user accounts, you can perform selected tasks in one 
operation, such as deleting, moving, or adding users to a group. For more information about your 
assigned powers, see Viewing Your Assigned Powers and Roles.

User Account Tasks in Account and Resource Management
You can execute all applicable tasks below from the Tasks menu or from the right-click menu. 
Generally, you select the All My Managed Objects node and execute a Find Now operation to locate 
and select the desired user object. In the case of creating a new user, you must select the domain or 
OU where you want to create the user. The Tasks menu indicates which tasks you can perform when 
you select single or multiple user accounts. 

Manage your own account 
You can manage your own account by modifying general properties, such as your telephone 
number. Before you manage your account, ensure you have the appropriate power.

Copy a user account to another ActiveView 
You can copy a user account to another ActiveView. This action is called transferring a user 
account. To copy a user account to another ActiveView, you need the Copy User to Another 
ActiveView power in both the source and target ActiveViews. Transferring a user account to 
another ActiveView does not remove the user account from the source ActiveView.

NOTE: Copying a user account to another ActiveView can only be done from the Delegation and 
Configuration Console via the Account and Resource Management node.

Rename a user account 
You can rename user accounts in the managed domain or managed subtree. Changing the user 
logon name also changes the name of the mailbox associated with the user account.

User Account Tasks in the Web Console
You can execute most of the tasks below from the Management > Search tab in the Web Console. 
Execute a search operation to locate and select the required user object. After you select one or 
more objects in the list, the taskbar becomes active with options such as create, account, and 
exchange. Click the options to display their functions.

Create a user account 
You can create user accounts in the managed domain or managed subtree. You can also modify 
properties, create a mailbox, enable email, and specify group memberships for the new 
account.

NOTE
 Your company may have a naming convention enforced through policy that determines the 

name you can assign to the new user account.
42 Managing User Accounts, Groups, and Contacts



 By default, DRA places the new user account in the Users OU of the managed domain.
 You cannot create InetOrgPerson objects in DRA.

Clone a user account 
When you clone a user account, any groups that the user is a member are automatically added 
to the new user account, saving you time in configuring the new account. You can add or 
remove groups from the new account, enable email, and make any other property 
configurations as you would with any new account.

NOTE: When you clone an InetOrgPerson object, you create a user account.

Modify user account properties 
You can manage the properties of user accounts in the managed domain or managed subtree. 
The powers you have determine which properties you can modify for a user account. If you 
installed Exchange and enabled Microsoft Exchange support, you can modify the associated 
mailbox properties while managing user accounts.

NOTE: If home directory policies are enabled, DRA automatically modifies the home directory 
of a user account when you manage that account. For example, when you change the home 
directory location, DRA attempts to create the specified home directory and move the contents 
of the previous home directory to the new location. DRA also applies the assigned ACLs from 
the previous directory to the new directory.

Exporting results: DRA enables you to export the Member Of results as a CSV file. To export the 
Member Of results from the Web Console, go to Management > Search and click Properties. 
Navigate to the Member Of tab and click the Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Enable a user account 
You can enable a user account in the managed domain or managed subtree. If you are 
managing a Microsoft Windows account, you can specify the domain controller at which DRA 
applies this change.
When you apply this change to a specific domain controller, DRA also applies this change to the 
default domain controller for this managed domain. To verify which default domain controller 
DRA is using, view the domain properties.

Disable a user account 
You can disable a user account in the managed domain. If you are managing a Microsoft 
Windows account, you can specify the domain controller at which DRA applies this change.
When you apply this change to a specific domain controller, DRA also applies this change to the 
default domain controller for this managed domain. To verify which default domain controller 
DRA is using, view the domain properties.
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Unlock a user account 
You can unlock a user account in the managed domain or managed subtree.
Because DRA retrieves the user account status from the accounts cache, the user interface may 
indicate that the selected account is unlocked when it is actually locked. DRA allows you to 
unlock a user account even if the account status indicates it is currently unlocked. You can also 
specify a domain controller when unlocking a user account using the DRA console without 
having to reset the user account password. 

Reset a user account password 
You can reset the password for an account in the managed domain or managed subtree. The 
powers you have determine the fields you can change for that user account.
When you reset the password for a user account, DRA automatically unlocks the account. You 
can select whether DRA generates a new password for the user account. You can also modify 
several password-related options for the account. If you are managing a Microsoft Windows 
account, you can specify the domain controller at which DRA applies these changes

NOTE: When you apply this change to a specific domain controller, DRA also applies this change 
to the default domain controller for this managed domain. To verify which default domain 
controller DRA is using, view the domain properties. 

Move a user account to another container 
You can move a user account to another container, such as an OU, in the managed domain or 
managed subtree.

Delete a user account 
You can delete a user account in the managed domain or managed subtree. If the Recycle Bin is 
disabled for that domain, deleting a user account permanently removes the user account from 
the Active Directory. If the Recycle Bin is enabled for that domain, deleting a user account 
moves the user account to the Recycle Bin.

WARNING: When you create a user account, Microsoft Windows assigns a Security Identifier 
(SID) to that account. The SID is not generated from the account name. Microsoft Windows uses 
SIDs to record privileges in access control lists (ACLs) for each resource. If you delete a user 
account, you cannot return access capabilities for that account by creating a new user account 
with the same name.

Specify group membership for user accounts 
You can add or remove user accounts from a specific group in the managed domain or managed 
subtree. You can also view or modify properties of existing groups to which this account 
belongs.

Transforming User Accounts
DRA offers you the ability to quickly and efficiently transform user accounts. When the individual 
associated with a user account transitions to new job responsibilities, you can use the transform 
capabilities of DRA. Taking advantage of job role templates, you can quickly add, remove, or update 
the group memberships associated with an account. Whether an individual is promoted, changes 
departments, or leaves the company, the ability to transform a user account will save you time, 
money, and guesswork.
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Understanding the Transformation Process
You can use the transform user account capabilities to fulfill any of the following needs:

 Remove group memberships from a user account
 Add group memberships to a user account
 Change user properties
 Remove particular group memberships while adding other group memberships to a user 

account

Consider the following process before attempting to transform a user account:

1 Decide whether you need to add, remove, or both add and remove group memberships.
2 Review your current subtractive and additive templates to ensure you have the necessary 

template user accounts.
3 If necessary, create any required template accounts.
4 Complete the Transform User wizard.

As DRA transforms a user, the group memberships designated by the subtractive template are 
removed from the user account, while those memberships designated by the additive template are 
assigned to the user account. DRA leaves any memberships outside of the subtractive or additive 
templates intact. For example, an individual in your outside sales department is transferred from US 
sales to European sales. Within your organization, you have both distribution groups and security 
groups that are unique for these sales teams and a number that are shared across all sales teams. 
The US sales team has the US Hotspots DL and the US Sales Mgmt DL distribution groups while the 
European sales team has Euro Hotspots and Euro Sales Mgmt distribution groups. Both teams are 
members of the Global Sales Sec security group, but also have individual site-specific security 
groups. 

Your subtractive template, named US Sales Template, would be assigned the following group 
memberships:

 US Hotspots DL
 US Sales Mgmt DL
 Global Sales Sec
 US Sec

Your additive template, named Euro Sales Template, would be assigned the following group 
memberships:

 Euro Hotspots DL
 Euro Sales Mgmt DL
 Global Sales Sec
 Euro Sec

During the transformation process, the user account of the transferred sales person is first removed 
from all the group memberships designated by the US Sales Template, and then added to all the 
group memberships designated by the Euro Sales Template. If this individual was also a member of 
the Poker Players distribution group, this group membership remains untouched.
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The following powers allow an Assistant Administrator to further modify a user account during the 
transformation process:

 Modify Address Properties while Transforming a User Account
 Modify Description while Transforming a User Account
 Modify Office while Transforming a User Account
 Modify Telephone Properties while Transforming a User Account

You can also restrict the ability to add or remove group memberships by giving an Assistant 
Administrator only one of the following powers:

 Add a user to groups found in a template
 Remove a user from groups found in a template

You can use either of these power-based limiting options to create a layer of security within your 
organization. By giving certain individuals the power to only remove groups found in a template, you 
can create interim user accounts. These interim accounts can then be reviewed before a different 
Assistant Administrator uses an additive template account to grant the new group memberships.

Creating User Transformation Templates
Transformation of user accounts is directly tied to the roles and job ladders of your organization. 
Consider creating a template for each role or job within your company. DRA makes no distinction 
between a user account template used as subtractive versus additive. Create a single template user 
account for each role within your organization. During the transformation, you select the template 
as subtractive or additive. Selecting a template as subtractive does not stop the same template from 
being used as additive in a future transformation.

To create a user transformation template, you must have the powers to create a user account and 
assign that user account to the appropriate groups. These powers can be obtained through 
associating your account with the Create and Delete User Accounts and the Group Administration 
roles in the appropriate ActiveViews or through the assigning of individual powers.

Transforming User Accounts
Transforming a user account enables you to add, remove, or both add and remove user account 
group memberships. Use this workflow to help you when individuals transition from one job 
responsibility to another within your organization. You must have the Transform a User role or a role 
that contains the appropriate powers to transform user accounts. This function can only be done 
from Delegation and Configuration console via the Account and Resource Management node.

To transform a user account:

1 In the left pane, expand All My Managed Objects.
2 To specify the user account you want to manage, execute a Find Now operation to locate and 

then select the user object.
3 Click Tasks > Transform.
4 Review the Welcome window, and then click Next.
5 On the Select User Template window, use Browse to the select the appropriate subtractive 

template user.
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6 If you want to review the properties of the subtractive template user account, click View.
7 Use Browse to the select the appropriate additive template user.
8 If you want to review the properties of the additive template user account, click View.
9 If you have the appropriate powers, you can check Change other properties of the user and 

select properties to modify. Click Next to navigate through the properties available.
10 Click Next.
11 Review the Summary window, and then click Finish.

Managing Groups
As an Assistant Administrator, you can use DRA to manage groups and modify group properties. 
Groups enable you to give specific permissions to a defined set of user accounts. Groups let you 
control which data and resources a user account can access in any domain.

You can manage groups of any type and scope. For example, you can nest groups, allowing one 
group can inherit permissions from another group. You can also effectively control group 
memberships across domains by adding groups from trusted domains to other groups in the 
managed domain and by managing temporary group assignments.

To learn more about managing groups, see the following topics:

 “Group Management Tasks” on page 47
 “Managing Temporary Group Assignments in the Delegation and Configuration Console” on 

page 50
 “Managing Temporary Group Assignments in the Web Console” on page 51

Group Management Tasks
This section guides you through administering groups in the Delegation and Configuration console 
via the Account and Resource Management node. With the appropriate powers, you can perform 
various group management tasks, such as modifying group memberships. If you select multiple 
groups, you can perform selected tasks in one operation, such as deleting, moving, or adding 
members to a group. The Tasks menu indicates which tasks you can perform when you select single 
or multiple groups.

Add accounts to groups 
You can add user accounts, contacts, and computers to a managed group.

NOTE: This task adds multiple accounts to a selected group. You can add a single account to a 
group by selecting the appropriate account and then clicking Add to groups on the Tasks menu.
If adding an account to another group increases your powers for the account, DRA does not 
permit you to add the account.

Add groups to other groups 
You can nest groups by adding a group to another managed group. When a group is nested in 
another group, the child group can inherit permissions from the parent group
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NOTE: If adding a group to another group increases your powers for the source group, DRA does 
not permit you to add the group.

Modify group properties 
You can modify properties for local and global groups. The powers you have determine which 
properties you can modify for a group in the managed domain or managed subtree. If you 
installed Exchange and enabled Microsoft Exchange support, you can modify distribution list 
properties while managing groups.

Create a group 
You can create a group in the managed domain or managed subtree. You can also modify 
properties, such as group members, for the new group.

NOTE
 Your company may have a naming convention enforced through policy that determines the 

name you can assign to the new group.
 By default, DRA places the new group in the Users OU of the managed domain.

Specify group members 
You can add or remove user accounts, contacts, computers, or other groups from the managed 
group. DRA allows you to only remove foreign security principals. You can also view or modify 
properties of existing group members, except for foreign security principals.
When you remove members from a group, DRA does not delete the objects. When you add 
members to a group, you must have the power to modify the objects you want to add.

NOTE: You cannot add user accounts or groups to any of the Windows special groups 
(Administrators, Account Operators, Backup Operators, or Server Operators) unless you are a 
Windows administrator or a member of that specific special group.

Exporting results: DRA enables you to export the Members results as a CSV file. To export the 
Members results from the Web Console, go to Management > Search and click Properties. 
Navigate to the Members tab and click the Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Specify group membership for groups 
You can add or remove a group from other groups in the managed domain or managed subtree. 
You can also view or modify properties of existing groups to which this group belongs.
Exporting results: DRA enables you to export the Member Of results as a CSV file. To export the 
Member Of results from the Web Console, go to Management > Search and click Properties. 
Navigate to the Member Of tab and click the Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.
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Configure group membership security permissions 
You can set Active Directory security permissions for group memberships. These permissions 
specify who can view (read) and modify (write) group memberships using Microsoft Outlook. 
These settings let you more effectively secure distribution lists and security groups in your 
environment. You cannot modify inherited security permissions.

NOTE: When you manage group membership security, disabled permissions may indicate 
inherited permissions.

Configure group ownership 
You can set the ownership of any Microsoft Windows distribution or security groups. You can 
grant the group ownership permission to a user account, group, or contact. Granting group 
ownership allows the specified user account, group, or contact to modify the membership of 
this group.

NOTE: DRA disables the Manager can update membership list check box when group 
membership is hidden from the Microsoft Exchange server. To enable this check box, click 
Expose Group Membership on the Exchange tab of the Group Properties window. 

Clone a group 
You can clone both local groups and global groups in managed domains. Cloning groups creates 
new groups of the same type and attributes as the original group. DRA also attempts to add all 
members from the original group to the new group.
By cloning a group, you can quickly create groups based on other groups with similar properties. 
When you clone a group, DRA populates the Clone Group Wizard with values from the selected 
group. You can also modify properties for the new group.

NOTE
 Your company may have a naming convention enforced through policy that determines the 

name you can assign to the new group.
 By default, DRA places the new group in the Users OU of the managed domain.

Delete a group 
You can delete local and global groups in the managed domain or managed subtree. If the 
Recycle Bin is disabled for that domain, deleting a group permanently removes the group from 
the Active Directory. If the Recycle Bin is enabled for that domain, deleting a group moves the 
group to the Recycle Bin and disables the group properties.
For more information on the Recycle Bin, see Managing the Recycle Bin.

WARNING: When you create a group, Microsoft Windows assigns a Security Identifier (SID) to 
that group. The SID is not generated from the group name. Microsoft Windows uses SIDs to 
record privileges in access control lists (ACLs) for each resource. If you delete a group, you 
cannot return access capabilities for that group by creating a new group with the same name.

Move a group to another container 
You can move a group to another container, such as an OU, in the managed domain or managed 
subtree.
Managing User Accounts, Groups, and Contacts 49



Expose group memberships in distribution lists 
You can expose group memberships in distribution lists for groups in the managed domain or 
managed subtree.

Hide group memberships from distribution lists 
You can hide group memberships in distribution lists for groups in the managed domain or 
managed subtree.

Managing Temporary Group Assignments in the Delegation and 
Configuration Console
Temporary group assignments enable you to manage group memberships for users who only need 
group membership for a specific time period. This section guides you through administering 
temporary group assignments in the Delegation and Configuration console under Account and 
Resource Management. With the appropriate powers, you can perform tasks such as creating 
temporary group assignments or removing expired temporary group assignments.

Assistant administrators can only view temporary group assignments for groups that the Assistant 
Administrator has powers to add or remove members.

You cannot change the associated group or modify the list of users while the temporary group 
assignment is in the Active state. If you want to modify these items you must cancel the temporary 
group assignment.

Manage temporary group assignment properties 
You can manage properties for temporary group assignments or saved expired temporary group 
assignments.
If you want to reschedule a temporary group assignment, change the schedule in the 
assignment’s Properties and save your changes.

Create a temporary group assignment 
You can create a temporary group assignment on the primary and secondary Administration 
servers.
By default when a temporary group assignment expires, it is deleted after seven days unless you 
have selected the Keep this temporary group assignment for future use option. To change this 
retention period, right-click the Temporary Group Assignment node under All My Managed 
Objects, select Properties, and modify the number of days to retain temporary group 
assignments.

Manage user accounts in a temporary group assignment 
You can add or remove user accounts from temporary group assignments on the primary and 
secondary Administration servers.

NOTE: You can only manage user accounts for temporary group assignments that are not yet 
active.

Delete a temporary group assignment 
You can delete any temporary group assignment on the primary and secondary Administration 
servers.
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Managing Temporary Group Assignments in the Web Console
Temporary group assignments enable you to manage group memberships for users who need group 
membership for a specific time period. In the Web Console, you can create and manage assignments 
from both DRA primary and secondary servers. However, actions that you can take on existing 
assignments vary depending on the state the assignment is in. 

Assistant administrators can view temporary group assignments only for groups for which they have 
powers to modify by their ActiveView assignments, such as adding or removing members of the 
group.

To manage temporary group assignments in the Web Console, navigate to Tasks > Temporary Group 
Assignments.

You can perform the following actions:

Search for existing assignments 
When you search for existing temporary group assignments (TGA), they are listed in the results 
based on the status of the assignment, which can include the following states:
 Pending: The TGA is scheduled to start in the future. You can perform cancel, delete, and 

re-schedule.
 Active: The TGA has started and added applicable members to the group. You can perform 

cancel and delete.
 Active with Error: The TGA has started, but failed to add all applicable members to the 

group. You can perform cancel and delete.
 Completed: The TGA has expired and removed all applicable members from the group. You 

can perform delete and re-schedule.
 Completed with Error: The TGA has expired, but failed to remove all applicable members 

from the group. You can perform delete and re-schedule.
 Canceled: The TGA was canceled by a user and removed all applicable members from the 

group. You can perform delete and re-schedule.
 Canceled with Error: TGA was canceled by a user, but failed to remove all applicable 

members from the group. You can perform delete and re-schedule.
 Error: TGA failed to add or failed to remove all the members. You can perform delete and 

re-schedule.
You can filter the results based on these states and other criteria including the assignment 
name, target group, duration time, and administrator who created the assignment.

Create a temporary group assignment 
You can create temporary group assignments using groups for which you have the powers to 
modify and also specify the domain controller. When the temporary group assignment expires, 
DRA automatically deletes it after seven days unless you select the option to keep the 
temporary group assignment for future use.

View or Modify temporary group assignment properties 
You can view or modify any of the temporary group assignments that were defined when the 
temporary group assignment was created. After executing a search for temporary group 
assignments, select an assignment to view or modify its properties.
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If you want to reschedule a temporary group assignment, change the schedule in the 
assignment’s Properties and save your changes. If the assignment is in the Active state, you can 
only change the end date.

IMPORTANT: You may not change the associated group or modify the list of users when the 
temporary group assignment is in the Active state. If you want to modify these items, you must 
first cancel the assignment.

Cancel a temporary group assignment 
You can cancel a temporary group assignment only when it is in one of the following states: 
 Active
 Active with Error
 Pending

Delete a temporary group assignment 
You can select multiple temporary group assignments and delete them. If the selected 
temporary group assignments are in the Active, Active with Error, or Pending state, then the 
Cancel option is also enabled.

Managing Dynamic Distribution Groups
A dynamic distribution group is a mail-enabled Active Directory group object that you can create to 
expedite the mass sending of email messages and other information.

The membership list for a dynamic distribution group is calculated each time a message is sent to 
the group, based on the filters and conditions that you define. This differs from a regular distribution 
group, which contains a defined set of members. When an email message is sent to a dynamic 
distribution group, it is delivered to all recipients in the organization that match the criteria defined 
for that group.

DRA supports the following features:

 Audit and UI reporting
 Enumeration support for dynamic distribution groups
 NetIQ Reporting Center (NRC) report for dynamic distribution groups
 Trigger operation support for dynamic distribution groups
 UI extension support for Exchange dynamic distribution groups

Dynamic distribution group tasks:

Create a dynamic distribution group 
You can create a dynamic distribution group in the managed domain or managed subtree. You 
can also modify properties, such as group members, for the new dynamic distribution group.
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NOTE
 Your company may have a naming convention enforced through policy that determines the 

name you can assign to the new dynamic distribution group.
 By default, DRA places the new dynamic distribution group in the Users OU of the managed 

domain.

Clone a dynamic distribution group 
You can clone both local and global dynamic distribution groups in managed domains. Cloning 
dynamic distribution groups creates new dynamic distribution groups of the same type and 
attributes as the original dynamic distribution group.
By cloning a dynamic distribution group, you can quickly create dynamic distribution groups 
based on other dynamic distribution groups with similar properties. When you clone a dynamic 
distribution group, DRA populates the Clone Dynamic Distribution Group Wizard with values 
from the selected dynamic distribution group. You can also modify properties for the new 
dynamic distribution group.

Move a dynamic distribution group to another container 
You can move a dynamic distribution group to another container, such as an OU, in the 
managed domain or managed subtree.

Delete a dynamic distribution group 
You can delete local and global dynamic distribution groups in the managed domain or 
managed subtree. If the Recycle Bin is disabled for that domain, deleting a dynamic distribution 
group permanently removes the dynamic distribution group from the Active Directory. If the 
Recycle Bin is enabled for that domain, deleting a dynamic distribution group moves it to the 
Recycle Bin and disables the dynamic distribution group’s properties.
For more information on the Recycle Bin, see Managing the Recycle Bin.

WARNING: When you create a dynamic distribution group, Microsoft Windows assigns a 
Security Identifier (SID) to that dynamic distribution group. The SID is not generated from the 
dynamic distribution group name. Microsoft Windows uses SIDs to record privileges in access 
control lists (ACLs) for each resource. If you delete a dynamic distribution group, you cannot 
return access capabilities for that dynamic distribution group by creating a new dynamic 
distribution group with the same name.

Modify dynamic distribution group properties 
You can modify properties for local and global dynamic distribution groups. The powers you 
have determine which properties you can modify for a group in the managed domain or 
managed subtree.

Specify a filter 
A dynamic distribution list’s membership is determined by its filter, which you can define.

Specify conditions 
Conditions define the criteria that an object must meet in order to be a member of the dynamic 
distribution group.
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Managing Dynamic Groups
A dynamic group is one whose membership changes based on a defined set of criteria. In DRA, you 
can create dynamic groups without having an Exchange environment. The membership filters used 
to manage dynamic groups in Active Directory are unique to DRA.

The graphic below describes a typical use for an Active Directory dynamic group. There are three 
dynamic groups in the graphic. Each group has a set of criteria that determines who can be added to 
the group and who can not. Each group controls access to a specific set of files, folders, and 
applications.

TIP: You can create a static member list that contains permanent members of the dynamic group; 
you can also create an excluded member list that denies those users membership in the dynamic 
group.

User2 has recently joined the IT department. When the IT department’s dynamic group is updated, 
she will be added to the group. When the Sales department’s dynamic group is updated, User2 will 
be removed from its members list.

TIP: You can refresh a dynamic group’s member list by right-clicking it and selecting Update 
Members.

User3, who has left the IT department for the HR department, will be removed from the IT 
department dynamic group and added to the HR department dynamic group.

Create a dynamic group 
You can create a dynamic group in the managed domain or managed subtree. You can also 
modify properties, such as group members, for the new dynamic group.

NOTE
 Your company may have a naming convention enforced through policy that determines the 

name you can assign to the new dynamic group.
 By default, DRA places the new dynamic group in the Users OU of the managed domain.
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Create a filter 
The dynamic group uses the filter to add or remove users from its membership list each time 
the group is refreshed.

Manage the static member list 
Users placed on a dynamic group’s static member list become permanent member of the group 
until you manually remove them.
When you remove members from a dynamic group, DRA does not delete the objects. When you 
add members to a dynamic group, you must have the power to modify the objects you want to 
add.

Manage the excluded member list 
Users placed on a dynamic group’s excluded member list will not be allowed to join the group 
until you manually remove them from this list.

Refresh the member list 
You can refresh the members in a dynamic group by an Update Members action.

Clone a dynamic group 
You can clone both local and global dynamic groups in managed domains. Cloning dynamic 
groups creates new dynamic groups of the same type and attributes as the original dynamic 
group.
By cloning a dynamic group, you can quickly create dynamic groups based on other dynamic 
groups with similar properties. When you clone a dynamic group, DRA populates the Clone 
Dynamic Group Wizard with values from the selected dynamic group. You can also modify 
properties for the new dynamic group.

Move a dynamic group to another container 
You can move a dynamic group to another container, such as an OU, in the managed domain or 
managed subtree.

Delete a dynamic group 
You can delete local and global dynamic groups in the managed domain or managed subtree. If 
the Recycle Bin is disabled for that domain, deleting a dynamic group permanently removes it 
from the Active Directory. If the Recycle Bin is enabled for that domain, deleting a dynamic 
group moves it to the Recycle Bin and disables the dynamic group’s properties.
For more information on the Recycle Bin, see Managing the Recycle Bin.

WARNING: When you create a dynamic group, Microsoft Windows assigns a Security Identifier 
(SID) to that dynamic group. The SID is not generated from the dynamic group name. Microsoft 
Windows uses SIDs to record privileges in access control lists (ACLs) for each resource. If you 
delete a dynamic group, you cannot return access capabilities for that dynamic group by 
creating a new dynamic group with the same name.

Modify dynamic group properties 
You can modify properties for local and global dynamic groups. The powers you have determine 
which properties you can modify for a group in the managed domain or managed subtree.
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Exporting results: DRA enables you to export the Members and Member Of results as a CSV file. 
To export the Members or Member Of results from the Web Console, go to Management > 
Search and click Properties. Navigate to the Members or the Member Of tab and click the 
Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Add dynamic groups to other dynamic groups 
You can nest dynamic groups by adding a dynamic group to another managed dynamic group. 
When a dynamic group is nested in another dynamic group, the child dynamic group can inherit 
permissions from the parent dynamic group.

NOTE: If adding a dynamic group to another dynamic group increases your powers for the 
source dynamic group, DRA will not permit you to add the dynamic group.

Configure group membership security permissions 
You can set Active Directory security permissions for dynamic group memberships. These 
permissions specify who can view (read) and modify (write) dynamic group memberships using 
Microsoft Outlook. These settings let you more effectively secure distribution lists and security 
dynamic groups in your environment. You cannot modify inherited security permissions.

NOTE: When you manage dynamic group membership security, disabled permissions may 
indicate inherited permissions.

Configure dynamic group ownership 
You can grant the dynamic group ownership permission to a user account, group, or contact. 
Granting dynamic group ownership allows the specified user account, group, or contact to 
modify the membership of this dynamic group.

Expose dynamic group memberships in distribution lists 
You can expose dynamic group memberships in distribution lists for groups in the managed 
domain or managed subtree.

Hide dynamic group memberships from distribution lists 
You can hide dynamic group memberships in distribution lists for groups in the managed 
domain or managed subtree.

NOTE: The Hide Group Membership option is disabled for Microsoft Exchange 2007 distribution 
lists.
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Managing Contacts
DRA enables you to manage many network objects, including contacts and the associated email 
addresses. Contacts are available only in mixed mode or native Microsoft Windows domains. 
Contacts do not have a Security Identifier (SID), as do user accounts and groups. Use contacts to add 
members to distribution lists or groups without granting them access to the network services.

You can add contacts to security or distribution groups in mixed and native mode domains. Because 
security groups can be used as distribution lists in Microsoft Windows, you may want to add contacts 
to these groups. Having a contact in a global security group does not prevent the group from being 
converted to a universal security group when you migrate to a native mode Microsoft Windows 
domain.

Modify contact properties 
You can modify contact properties. The powers you have determine which properties you can 
modify for a contact in the managed domain. If you installed Exchange and enabled Exchange 
support, you can modify email address properties while managing the contacts.
Exporting results: DRA enables you to export the Member Of results as a CSV file. To export the 
Member Of results from the Web Console, go to Management > Search and click Properties. 
Navigate to the Member Of tab and click the Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Create a contact 
You can create contacts in the managed domain or managed subtree. You can also modify 
properties, enable email and specify email addresses, and specify group memberships for the 
new contact.

Clone a contact 
By cloning a contact, you can quickly create contacts based on other contacts with similar 
properties. When you clone a contact, DRA populates the Clone Contact Wizard with values 
from the selected contact. You can also modify properties, enable email and specify email 
addresses, and specify group memberships for the new contact.

Manage group memberships for contacts 
You can add or remove contacts from a specific group in the managed domain or managed 
subtree. You can also view or modify properties of existing groups to which this contact 
belongs.

Move a contact to another OU 
You can move a contact to another container, such as an OU, in the managed domain or 
managed subtree.

Delete a contact 
You can delete a contact from the managed domain or managed subtree. If the Recycle Bin is 
disabled for that domain, deleting a contact permanently removes the contact from the Active 
Directory. If the Recycle Bin is enabled for that domain, deleting a contact moves the contact to 
the Recycle Bin.
For more information on the Recycle Bin, see Managing the Recycle Bin.
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5 5Managing Azure User Accounts and Groups

This chapter contains conceptual and procedural information for managing Azure user accounts and 
Azure groups in the Web Console. With the appropriate powers, you can perform various Azure user 
and Azure group management tasks, such as creating and deleting Azure user account objects. 

You can execute most of the tasks for Azure user and Azure group objects from the Management > 
Search tab in the Web Console by searching for objects in one of the following nodes:

 All My Managed Objects
 All My Managed Tenants
 A sub-node of All My Managed Tenants

Managing Azure User Accounts
As an Assistant Administrator, you can use DRA to manage Azure user accounts and modify Azure 
user account properties when Azure Active Directory is configured by the DRA Administrator.

Execute a search operation to locate and select the required Azure user object. After you select one 
or more objects in the list, the taskbar becomes active with options such as delete, allow, block, 
password reset, Office 365 mailbox properties, and modify properties. Click the options to display 
their functions.

Create an Azure user account 
You can create Azure user accounts in the Azure Active Directory.

Modify Azure user account properties 
You can manage the properties of Azure user accounts in the Azure Active Directory.
The powers you have determine which properties you can modify for an Azure user account
Exporting results: DRA enables you to export the Member Of results as a CSV file. To export the 
Member Of results from the Web Console, go to Management > Search and click Properties. 
Navigate to the Member Of tab and click the Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Allow Sign-In Azure user account  
You can enable an Azure user account for signing in to the Azure Active Directory.

Block Sign-In Azure user account  
You can block an Azure user account from signing in to the Azure Active Directory.

Reset an Azure user account password  
You can reset the password for an Azure user account in Azure Active Directory and choose 
whether DRA generates a new password for the account.
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Delete an Azure user account  
You can delete an Azure user account from Azure Active Directory, but it cannot be restored 
from DRA.

Specify an Azure group membership for Azure user accounts  
You can add or remove Azure user accounts from a specific Azure group in the Azure Active 
Directory.

Managing Azure Groups
As an Assistant Administrator, you can use DRA to manage Azure groups when Azure Active 
Directory is configured by the DRA Administrator. Azure groups enable you to give specific 
permissions to a defined set of user accounts. Azure groups let you control which data and resources 
a user account can access in any tenant.

This section guides you through administering Azure groups in the Web Console. With the 
appropriate powers, you can perform various Azure group tasks.

NOTE: Supported Members; Azure group members can be Azure users, Azure groups, synced users, 
and synced groups.

Add user accounts to Azure groups 
You can add user accounts (both on-premises and Azure) to an Azure managed group.
This task adds multiple accounts to a selected group. You can add a single account to a group by 
selecting the appropriate account.
If adding an account to another group increases your powers for the account, DRA does not 
permit you to add the account.

Nest groups in Azure 
You can nest groups by adding other groups (both on-premises and Azure) to a managed Azure 
group. When a group is nested in an Azure group, the child group inherits permissions from the 
parent group.
If adding a domain or Azure group to another Azure group increases your powers for the source 
group, DRA does not permit you to add the group.

Create an Azure group 
You can create an Azure group in Azure Active Directory. You can also modify properties, such as 
adding Azure group members to the new group.
If an owner is not specified, by default DRA provides the Azure tenant access account as the 
owner.

Modify Azure group properties 
The powers you have determine which properties you can modify for a group in the Azure 
Active Directory.
Exporting results: DRA enables you to export the Members and Member Of results as a CSV file. 
To export the Members or Member Of results from the Web Console, go to Management > 
Search and click Properties. Navigate to the Members or the Member Of tab and click the 
Download icon.
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NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Configure Azure group ownership  
You can set the ownership of any groups. You can grant the group ownership permission to a 
user account or group. Granting group ownership allows the specified user account or group to 
manage the group including membership.

Delete an Azure group  
You can delete Azure groups from Azure Active Directory, but they cannot be restored from 
DRA.
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6 6Managing Exchange Mailboxes and Public 
Folders

Using DRA you can manage Microsoft Exchange mailboxes as an extension of user account 
properties. This integration enables you to simplify your administration workflows so you can 
effectively administer Exchange properties. You can also link mailboxes from user account and 
Exchange account forests and manage resource mailboxes, shared mailboxes, and public folders.

Managing Mailbox Tasks in the Delegation and Configuration Console
When using the ARM node, you execute applicable mailbox tasks from the Exchange Tasks tab in the 
object’s properties, which is also accessible from the Tasks or the right-click menu for a selected 
object. Generally, you select the All My Managed Objects node and execute a Find Now operation to 
locate and select the desired object. 

Managing Mailbox Tasks in the Web Console
When using the Web Console, you execute the applicable mailbox tasks below from the 
Management > Search tab. Generally, you execute a search operation to locate and select the 
required mailbox object. After you select one or more objects in the list, the taskbar becomes active. 
Click the options to display their functions.

Management Tasks for User Mailboxes
You can manage Microsoft Exchange mailboxes for user accounts in the managed domain or 
managed subtree. Each aspect of managing Microsoft Exchange mailboxes requires different 
powers. The powers you have control which mailbox properties you can modify, or whether you can 
create, clone, view, or delete Microsoft Exchange mailboxes. You can also manage mailbox rights and 
permissions associated with a user account, allowing you to control the security of your Microsoft 
Exchange environments. If you do not have the required power to modify a tab or field for the 
selected mailbox, DRA disables the tabs and fields that you cannot modify.

In addition to the tasks defined below, user accounts may have options enabled in the object 
properties by the DRA Administrator to configure settings for Skype and Skype Online. Skype can be 
configured from user accounts in both the Delegation and Configuration Console and the Web 
Console. Skype Online can only be configured from the Web Console.

Create a mailbox 
You can create a Microsoft Exchange mailbox for an existing user account. You can also modify 
properties for the new mailbox.

NOTE: When you create a mailbox, Exchange generates the necessary proxy strings based on 
your Exchange policy settings. Microsoft Exchange also generates default proxy strings. As a 
result, when you view the properties of the newly created mailbox, you see both types of proxy 
strings.
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Clone a user account 
When you clone a user account, any groups that the user is a member are automatically added 
to the new user account, saving you time in configuring the new account. You can add or 
remove groups from the new account, enable email, and make any other property 
configurations as you would with any new account.

NOTE: When you clone an InetOrgPerson object, you create a user account.

Move a mailbox 
You can move a Microsoft Exchange mailbox for a user account to another mailbox store or 
Microsoft Exchange server.

Modify mailbox properties 
You can modify properties for Microsoft Exchange mailboxes as you manage the associated user 
accounts. The powers you have determine which mailbox properties you can modify.

NOTE: You cannot modify mailbox properties of user accounts managed on member servers.

Configure mailbox security permissions 
You can specify which user accounts, groups, or computers you want to grant or deny the ability 
to send and receive email using a specific Microsoft Exchange mailbox. These settings let you 
more effectively secure your Exchange environment. You cannot modify inherited security 
permissions.

NOTE: When you manage mailbox security, disabled permissions may indicate inherited 
permissions.

Remove mailbox security permissions 
You can remove mailbox security permissions from a user account, group, or computer 
associated with a Microsoft Exchange mailbox. Removing mailbox security permissions prevents 
the user account, group, or computer account from sending and receiving email through the 
specified mailbox. You cannot remove inherited security permissions.

Configure mailbox rights 
You can grant or deny other user accounts, groups, or computers rights to a specific Microsoft 
Exchange mailbox. These settings let you more effectively secure your Exchange environment. 
You cannot modify inherited mailbox rights.

NOTE: When you manage mailbox rights, disabled permissions may indicate inherited 
permissions.

Remove mailbox rights 
You can remove mailbox rights from user accounts, groups, or computers associated with a 
specific Microsoft Exchange mailbox. Removing mailbox rights prevents the user account, 
group, or computer account from using the specified mailbox. You cannot remove inherited 
mailbox rights.
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Delete a mailbox 
You can delete a mailbox associated with a user account in the managed domain or managed 
subtree. Deleting a mailbox also deletes all messages in the mailbox.

Add or modify an email address 
You can specify email addresses for mailboxes associated with user accounts in your managed 
domain or managed subtree. You can also assign email addresses to user accounts who do not 
yet have mailboxes. When managing Microsoft Exchange mailboxes, you can add only the email 
address types defined by your proxy generation policies.

Specify a reply address 
You can set reply addresses for a mailbox associated with a user account in the managed 
domain or managed subtree. You can set several reply addresses for a mailbox. However, you 
cannot set more than one email address type as a reply address. For example, you cannot 
specify more than one Internet address as a reply address.

Delete an email address 
You can delete an email address by removing the address from the mailbox.

Specify delivery options 
You can specify which mailboxes the user can use to send messages, set forwarding options, 
and specify recipient limits.

Specify delivery restrictions 
By setting delivery restrictions, you can limit the size of incoming and outgoing messages and 
the acceptance of incoming messages for a specific mailbox.

Specify storage limits 
You can specify storage limits, such as warnings based on the size of a mailbox. You can also 
specify retention times for deleted items.

Check mailbox move status 
You can check the status of mailbox moves and take actions on them, such as clearing the 
status, canceling a move, and resuming a move that has been interrupted.

Management Tasks for Office 365 Mailboxes
This section contains information for administering Microsoft Office 365 mailboxes in the Delegation 
and Configuration console via the Account and Resource Management node and in the Web 
Console. With the appropriate powers, you can perform various user account management tasks, 
such as placing litigation holds and setting up email forwarding.

IMPORTANT: DRA manages Office 365 user mailboxes as well as migrated shared, room, and 
equipment mailboxes. For DRA to manage these mailboxes they must be associated with an on-
premise user that is managed by DRA. The mailbox properties will be available through the property 
pages for those associated users.
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Place a litigation hold 
A litigation hold may be necessary when there is a reasonable expectation of a lawsuit. 
Organizations are required to preserve electronically stored information, including e-mail, that 
is relevant to the case.
Set a litigation hold on a mailbox to preserve all mailbox content, including deleted items and 
original versions of modified items. Placing a user's mailbox on litigation hold also preserves 
content, if it exists, in the user's archive mailbox as well. The hold can last for a specified period, 
or until you remove the Litigation Hold from the mailbox.
You must have an Exchange Online Enterprise E3 license to place a litigation hold. You configure 
the feature via the Litigation Hold tab in the user object’s properties.

Delegate mailbox Permissions 
You can delegate Office 365 mailbox permissions via the Mailbox delegation tab in the user 
object’s properties. There are three types of permissions that you can delegate, send as, send 
on behalf of, and full access.The types of permission that can be delegated depends upon the 
receiving object type.

Set up email forwarding 
You can enable mail forwarding for user accounts via the Mail flow option in the user object’s 
properties.

Management Tasks for Resource Mailboxes
Microsoft Exchange's resource mailbox feature enables you to create a mailbox that represents a 
resource such as a conference room so that you can reserve it by sending it a meeting invitation, just 
as you would a person. DRA contains a set of roles, powers, and policies that allow you to manage 
your resource mailboxes efficiently.

DRA has interface extension support for resource mailboxes as well as support for generating audit 
or user interface reports. Support for ADSI scripts is also integrated into DRA.

Create a resource mailbox 
You can create resource mailboxes in the managed domain or managed subtree.

Move a resource mailbox to another container 
You can move a resource mailbox to another container, such as an OU, in the managed domain 
or managed subtree.

Move a resource mailbox to another mailbox store or Exchange server 
You can move a resource mailbox to another mailbox store or Microsoft Exchange server.

Clone a resource mailbox 
By cloning a resource mailbox, you can quickly create other resource mailboxes with similar 
properties. When you clone a resource mailbox, DRA populates the Clone Resource Mailbox 
Wizard with values from the selected resource.

Rename a resource mailbox 
You can rename resource mailboxes in the managed domain or managed subtree. Changing the 
user logon name also changes the name of the mailbox associated with the user account.
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Add a resource mailbox to a group 
You can add resource mailboxes to a specific group in the managed domain or managed 
subtree.

Delete a resource mailbox 
You can delete a resource mailbox in the managed domain or managed subtree. Deleting a 
resource mailbox also deletes all messages in the mailbox and any disabled user objects 
associated with the resource mailbox. If desired, you can override the deletion of disabled user 
objects when you delete the mailbox. If you delete a user object associated with a resource 
mailbox the resource mailbox is also deleted.

Restore a deleted resource mailbox 
You can restore a resource mailbox that was deleted if the Recycle Bin from that domain is 
enabled.

Modify resource mailbox properties 
You can manage the properties of resource mailboxes in the managed domain or managed 
subtree. The powers you have determine which properties you can modify.
Exporting results: DRA enables you to export the Member Of results as a CSV file. To export the 
Member Of results from the Web Console, go to Management > Search and click Properties. 
Navigate to the Member Of tab and click the Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Management Tasks for Shared Mailboxes
Shared mailboxes are useful to Helpdesk administrators and technical support staff, because all 
responses can be configured to go into a single mailbox that multiple users can access. The mailbox 
must be in a DRA managed domain with the Exchange Policy enabled, and you must have powers 
delegated to you to manage shared mailboxes. 

When you create a shared mailbox, there are two types of permissions you can delegate to users: 
Send As and Full Access. Send As provides permission to read and send emails. You can delegate 
permissions to both user and group objects. You can also specify delivery restrictions, delivery 
options, storage limits, folder permissions, and several other options in the object’s properties.

NOTE: You can perform management tasks for shared mailboxes only through the Web Console.

Create a shared mailbox 
You can create shared mailboxes in the managed domain or managed subtree.

Move a shared mailbox to another container 
You can move a shared mailbox to another container, such as an OU, in the managed domain or 
managed subtree.

Move a shared mailbox to another mailbox store 
You can move a shared mailbox to another mailbox store.
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Clone a shared mailbox 
By cloning a shared mailbox, you can quickly create other shared mailboxes with similar 
properties. 

Rename a shared mailbox 
You can rename shared mailboxes in the managed domain or managed subtree. Changing the 
user logon name also changes the name of the mailbox associated with the user account.

Delete a shared mailbox 
You can delete a shared mailbox in the managed domain or managed subtree. If the Recycle Bin 
is disabled for that domain, deleting a shared mailbox permanently removes it from the Active 
Directory. If the Recycle Bin is enabled for that domain, deleting a shared mailbox moves it to 
the Recycle Bin.
Deleting a shared mailbox also deletes all messages in the mailbox and any disabled user 
objects associated with the shared mailbox. If you delete a user object associated with a shared 
mailbox the shared mailbox is also deleted.

Restore a deleted shared mailbox 
You can restore a shared mailbox that was deleted if the Recycle Bin from that domain is 
enabled.

Create an archive shared mailbox 
You can create archived shared mailboxes in the managed domain or managed subtree.

Delete an archive shared mailbox 
You can delete archived shared mailboxes in the managed domain or managed subtree.

Modify shared mailbox properties 
You can modify the properties of shared mailboxes in the managed domain or managed 
subtree. The powers you have determine which properties you can modify.
Exporting results: DRA enables you to export the Member Of results as a CSV file. To export the 
Member Of results from the Web Console, go to Management > Search and click Properties. 
Navigate to the Member Of tab and click the Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Management Tasks for Linked Mailboxes
Linked mailboxes are useful for large organizational changes that occur during mergers, acquisitions, 
and company splits, when mailbox migration is common. This feature enables linking mailboxes from 
different Exchange forests to negate disruption of user email. The mailboxes must be in DRA 
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managed domains with the Exchange Policy enabled, and you must have powers delegated to you to 
manage linked mailboxes. When you create a linked mailbox, a Linked Mailbox tab is added to the 
properties of the user object. 

Linked mailbox management is only supported in the Web Console. You create a linked mailbox from 
the toolbar of a selected user account. This option is only enabled when the selected user’s domain 
has an external forest trust with other managed domains in DRA. Only disabled user accounts will be 
listed when searching for an account to link to in another DRA managed domain.

Create a linked mailbox 
You can create a linked mailbox from two user accounts selected in different managed Exchange 
forests.

Delete a linked mailbox 
You can delete a linked mailbox from the toolbar of a selected user that has a linked mailbox.

Modify linked mailbox properties 
You can modify the properties of a linked mailbox from the Linked Mailbox tab in a selected 
user’s properties.

Create a linked archive mailbox 
You can create a linked archive mailbox from a selected user that has a linked mailbox.

Delete a linked archive mailbox 
You can delete a linked archive mailbox from the toolbar of a selected user that has a linked 
archive mailbox.

Restore a deleted linked mailbox 
You can restore a linked mailbox that was deleted if the Recycle Bin from that domain is 
enabled.

Management Tasks for Public Folders
If the DRA Administrator has created Public Folder forests in the DRA managed enterprise and 
granted you powers to manage public folders in DRA, you will be able to create public folders, 
modify their properties, and generate change history reports. Creating and modifying public folders 
can only be done in the Web Console. You can use the search option to search public folders. For 
information, see “Search” on page 35.

You execute Public Folder tasks from the Management > Public Folders tab.

Create a public folder 
You can create new public folders in specified Public Folder domains, subtrees, and mailboxes 
through the Web Console. You can use the default mailbox for the selected domain or choose 
one.

Enable email for a public folder 
You can enable email for a public folder using the Enable Mail option on the list toolbar. This 
enables you to associate email addresses with the public folder and modify the public folder’s 
properties.
Managing Exchange Mailboxes and Public Folders 69



Disable email for a public folder 
You can disable email for a public folder using the Disable Mail option on the list toolbar.

Modify public folder properties 
After enabling mail on an existing public folder, you can view the folder’s statistics, and modify 
the properties of that public folder. In these properties you can specify user delivery and 
restriction options, size limits and quota warnings, mail properties, storage age limits, inclusion 
of moderators to approve mail, and custom attributes.

NOTE: You can also update some properties for multiple public folders when more than one is 
selected, such as storage quotas.

Delete a public folder 
You can delete public folders if they do not have any sub-folders and the email option is 
disabled.
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7 7Managing Resources

DRA enables you to manage resources including computers, printers, and other devices, as well as 
processes associated with these resources. For example, if you need to start a specific service on a 
managed computer, you could search for that computer object in DRA, access its services through 
object properties, and then restart a specific service on that computer from DRA without ever 
having to remote in to that computer.

Managing Organizational Units (OUs)
This section guides you through administering OUs in the Delegation and Configuration console via 
the Account and Resource Management node. With the appropriate powers, you can perform 
various OU management tasks, such as moving an OU to another container. 

NOTE: You can manage OUs only through the Delegation and Configuration Console.

Modifying OU Properties 
You can modify properties for OUs. The powers you have determine which properties you can 
modify for an OU in the managed domain or managed subtree.

Creating an OU 
You can create an OU in the managed domain or managed subtree. You can also modify general 
properties, such as the OU description.

Cloning an OU 
You can create a new OU by cloning an existing OU from the managed domain or managed 
subtree. You can also modify general properties for new OU, such as the OU description. 
Cloning an OU does not clone the objects contained in the OU.

Opening the Active Directory Tree to an OU Location 
You can quickly and easily open the Active Directory tree to the location of a specific OU in the 
managed domain or managed subtree.

Moving an OU to Another Container 
You can move an OU to a different container in the managed domain. When managing a 
subtree of a domain, you can move OUs within the hierarchy of that subtree.

NOTE
 If moving an OU to another container increases your powers for the moved OU, DRA does 

not permit you to move the OU.
 You can also move an OU by dragging it to the new location.
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Deleting an OU 
You can delete OUs from the managed domain or managed subtree. You can only delete empty 
OUs. If an OU contains objects, you cannot delete the OU. In order to delete an OU that 
contains objects, delete all of the objects first, and then delete the OU.

Managing Computers
DRA enables you to administer computers in the managed domain or managed subtree. For 
example, you can add or remove computer accounts in the managed domains, as well as manage the 
resources on each computer. When you add a computer to a domain, DRA creates a computer 
account in that domain for that computer. You can then connect the computer in that domain and 
configure the computer to use that computer account. You can also view and modify the properties 
of computer accounts. DRA also lets you shut down a computer and synchronize domain controllers 
in a managed domain.

NOTE

 You can manage computers only through the Delegation and Configuration Console.
 You cannot manage hidden domain controllers. The domain cache does not include hidden 

domain controllers. Therefore, DRA does not display hidden domain computers in lists or 
property windows

Specify group membership for computers 
You can add or remove computers from a specific group in the managed domain or managed 
subtree. You can also view or modify properties of existing groups to which this computer 
belongs.
Exporting results: DRA enables you to export the Member Of results as a CSV file. To export the 
Member Of results from the Web Console, go to Management > Search and click Properties. 
Navigate to the Member Of tab and click the Download icon.

NOTE: The unsaved changes are not exported. Ensure you save any recent changes so they are 
available in the exported file.

Manage computer account properties 
You can manage computer account properties. The powers you have determine which 
properties you can modify for a computer in the managed domain or managed subtree.

Add a computer to a domain 
You can add a computer to a managed domain or managed subtree by creating a new computer 
account.

Remove a computer from a domain 
You can remove a computer from a managed domain or managed subtree by deleting the 
computer account.

Move a computer 
You can move a computer to another container, such as an OU, in the managed domain or 
managed subtree.
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Shut down or restart a computer 
You can shutdown and restart a computer immediately or at a set date and time.

Reset the Administrator account password 
To reset the administrator account password for a computer, you must have the Reset Password 
for Local Administrator power or be associated with a role that contains this power. You can 
reset the administrator password for member servers in your managed domain or managed 
subtree. You cannot reset the administrator password for a domain controller.

Reset the computer account 
You can reset a computer account for member servers in your managed domain or managed 
subtree. You cannot reset the computer account for a domain controller.

Delete a computer account 
You can delete a computer account from the managed domain or managed subtree. If you are 
managing a Microsoft Windows domain, you can delete computer accounts that contain other 
objects, such as a shared resource. Enable the Force Delete option to delete computer objects 
from Active Directory. This will also delete child objects, including printers and shared folders. 
Deleted computers and their associated objects are moved to the DRA Recycle Bin. If the 
Recycle Bin is disabled upon deletion, the objects are permanently deleted.

NOTE: You cannot delete computer accounts for member servers in the managed domain or 
managed subtree.

Disable a computer account 
You can disable a computer account in the managed domain or managed subtree. Disabling a 
computer account prevents users on that computer from logging on to any domain.

Enable a computer account 
You can enable a computer account in the managed domain or managed subtree. Enabling a 
computer account allows users on that computer to log on to any domain.

Manage computer resources 
For each computer account in the managed domain or managed subtree, you can manage the 
associated resources, such as services, shares, devices, printers, and print jobs.

Managing Services
A service is a type of application that gets special treatment from the Windows operating system. 
Services can run even when no user is currently logged on to a computer. DRA enables assistant 
administrators with the appropriate powers to manage services through the Account and Resource 
Management node of the Delegation and Configuration Console.

NOTE: You can manage services only through the Delegation and Configuration Console.

Manage service properties 
You can manage properties for services running on computers in the managed domain or 
managed subtree. You can manage services while managing other resources for that computer.
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Start a service 
You can start a service on any computer in the managed domain or managed subtree.

Start a service with parameters 
When you start services that accept parameters, you can specify these parameters at start up. 
You can start services on computers in the managed domain or managed subtree.

Specify a service startup type 
You can change the startup type of a service, such as requiring a manual startup.

Specify a service logon account 
You can change the service logon account to an account other than the current system account. 
You can specify logon accounts for services running on computers in the managed domain or 
managed subtree. You can specify the local system account or a specific user account.

Restart a service 
You can restart a service running on a computer in the managed domain or managed subtree.
To restart a service, you must have both the Stop a Service and Start a Service powers or be 
associated with a role that contains these powers, such as the Start and Stop Service role.

Stop a service 
You can stop a service running on a computer in the managed domain or managed subtree.

Pause a service 
You can pause a service running on a computer in the managed domain or managed subtree. 
Whether a service can be paused or not depends on the type of service. For example, you may 
not be able to pause a service that has dependent services.

Resume a paused service 
You can resume a service that was paused on a computer in the managed domain or managed 
subtree.

Managing Printers and Print Jobs
To manage printers, you manage the print queues that service those printers. DRA enables you to 
pause or resume, start, modify, stop, and view resource printers and published printers. DRA also 
lets you modify the properties and priorities of print jobs. To add or delete a printer, use the native 
Windows tools.

A print server is a computer on which one or more logical printers are installed. A logical printer is 
defined on the computer that has the printer device driver. A logical printer includes the print driver, 
print queue, and ports for a printer. The print server associates logical printers with printer devices.

A connected printer is defined on the computers from which documents are selected for printing. A 
connected printer is a connection to a print share on the network. Therefore, you can manage 
printers and print jobs through the associated computers.

A published printer is a printer published in Active Directory. A published printer can be a network 
printer that is not directly connected to a server or it can be a printer hosted by cluster server.
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NOTE: You can manage printers and print jobs only through the Delegation and Configuration 
Console.

To learn more about managing printers and print tasks, see the following topics:

 “Printer Management Tasks” on page 75
 “Print Job Management Tasks” on page 75
 “Published Printer Management Tasks” on page 76
 “Print Job Management Tasks for Published Printers” on page 77

Printer Management Tasks
You can manage printers associated with computers in the managed domain or managed subtree. 
DRA lets you manage printers while managing other resources for that computer.

This section guides you through administering printers in the Delegation and Configuration console 
via the Account and Resource Management node. With the appropriate powers, you can perform 
various printer management tasks, such as stopping a printer. 

Manage printer properties 
You can manage properties for printers in the managed domain or managed subtree. DRA lets 
you manage printers while managing other resources for that computer.

Pause a printer 
You can pause a printer associated with a computer in the managed domain or managed 
subtree. DRA lets you manage printers while managing other resources for that computer.

Resume a printer 
You can resume a printer associated with a computer in the managed domain or managed 
subtree. DRA lets you manage printers while managing other resources for that computer.

Print Job Management Tasks
You can manage print jobs associated with printers in the managed domain or managed subtree. 
Because print jobs are associated with a printer, you can manage print jobs while managing the 
printer.

This section guides you through managing print jobs in the Account and Resource Management 
node of the Delegation and Configuration console. With the appropriate powers, you can perform 
various print job management tasks, such as canceling a print job. 

Manage print job properties 
You can modify print job properties as part of your printer management workflow. Because 
print jobs are associated with printers, you can modify the print job while managing the 
corresponding printer. The print job properties you can modify depend on the type of power 
you have. To modify print job properties, you must be able to access the corresponding printer 
and computer.
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Pause a print job 
You can pause a print job on a printer in a managed domain or managed subtree. To pause a 
print job, you must be able to access the corresponding printer and computer. Pausing a print 
job does not delete the print job from the print queue.

Resume a print job 
You can resume a print job that was paused. To resume a print job, you must be able to access 
the corresponding printer and computer.

Restart a print job 
You can restart a print job that was stopped. To restart a print job, you must be able to access 
the corresponding printer and computer.

Cancel a print job 
You can cancel a print job that is in the printer queue. When you cancel a print job, DRA 
permanently deletes the print job from the printer queue. To cancel a print job, you must be 
able to access the corresponding printer and computer.

Published Printer Management Tasks
You can manage published printers in the managed domain or managed subtree. You can add or 
search for any printer that is published in the Active Directory or printers that are hosted by cluster 
server.

This section guides you through administering published printers in the Account and Resource 
Management node. With the appropriate powers, you can perform various printer management 
tasks, such as stopping a printer.

Manage published printer properties 
You can manage properties for published printers in the managed domain or managed subtree. 
DRA lets you manage published printers while managing other resources.

Refresh published printer information 
You can refresh the published printer information in the managed domain or managed subtree. 
DRA lets you manage published printers while managing other resources.

Pause a published printer 
You can pause a published printer in the managed domain or managed subtree. DRA lets you 
manage published printers while managing other resources.

Resume a published printer 
You can resume a published printer that was paused in the managed domain or managed 
subtree. DRA lets you manage published printers while managing other resources.

Move a Published Printer 
You can move a published printer available in one container in the managed domain to another 
container in the same domain. DRA lets you manage published printers while managing other 
resources.
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Rename a published printer 
You can rename a shared published printer in the Active Directory. DRA lets you manage 
published printers while managing other resources.

NOTE: Renaming a published printer in Active Directory does not change the resource printer 
share name or propagate the name change to the resource printer you want to manage. For 
example, if the resource printer name is Emerald and you rename the printer to Ruby in Active 
Directory, other users will see the printer name as Ruby, but the resource printer name will 
continue to be Emerald.

Print Job Management Tasks for Published Printers
You can manage printer jobs associated with published printers in the managed domain or managed 
subtree. Because print jobs are associated with a printer, you can manage print jobs while managing 
the published printer.

This section guides you through administering published printers in the Account and Resource 
Management node. With the appropriate powers, you can perform various print job management 
tasks, such as canceling a print job.

Manage print job properties 
You can modify print job properties as part of your published printer management workflow. 
Because print jobs are associated with printers, you can modify the print job while managing 
the corresponding published printer. The print job properties you can modify depend on the 
type of power you have. To modify print job properties, you must be able to access the 
corresponding published printer.

Pause a print job 
You can pause a print job on a published printer in a managed domain or managed subtree. To 
pause a print job, you must be able to access the corresponding published printer. Pausing a 
print job does not delete the print job from the print queue.

Resume a print job 
You can resume a print job that was paused in a managed domain or managed subtree. To 
resume a print job, you must be able to access the corresponding published printer.

Restart a print job 
You can restart a print job that was stopped in a managed domain or managed subtree. To 
restart a print job, you must be able to access the corresponding published printer.

Cancel a print job 
You can cancel a print job that is in the printer queue in a managed domain or managed 
subtree. When you cancel a print job, DRA permanently deletes the print job from the printer 
queue. To cancel a print job, you must be able to access the corresponding published printer.
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Managing Shares
A share is a way to make resources, such as files or printers, available to other users on the network. 
Each share has a share name that refers to a shared folder on the server. DRA manages the shares 
only on the computers in the managed domains. To successfully manage shares, the access account 
must have administrator permissions, such as being a member of the local Administrators group, on 
all computers where you want to manage resources. To assign these permissions, add the access 
account to the native Domain Admins group in the domain of the computer.

NOTE: You can manage shares only through the Delegation and Configuration Console.

Manage share properties 
You can manage properties for shares in the managed domain or managed subtree. DRA lets 
you manage shares while managing other resources for that computer.

Create a share 
You can create a share for a computer in the managed domain or managed subtree. You can 
also modify properties for this share.

Clone a share 
You can clone a share for a computer in the managed domain or managed subtree. By cloning a 
share, you can quickly create shares based on other shares with similar properties. This 
flexibility lets you enforce consistent settings for all shares you create in a given domain.
When you clone a share, DRA populates the Clone Share Wizard with values from the selected 
share. You can also modify properties for the new share.

Delete a share 
You can delete shares from computers in the managed domain or managed subtree.

Managing Connected Users
A session is established whenever a user connects to a particular resource on a remote computer. A 
connected user is a user connected to a shared resource on the network.

DRA manages the connected users only on the computers in the managed domains. The access 
account must have administrator permissions, such as being a member of the local Administrators 
group, on all computers where you want to manage connected users. To assign these permissions, 
add the access account to the native Domain Admins group in the domain of the computer.

NOTE: You can manage connected users only through the Delegation and Configuration Console.

Disconnect a User 
You can disconnect a connected user from a computer in the managed domain or managed 
subtree. You must be able to access the computer and this open session. Disconnecting a 
connected user ends the open session.
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Refresh the list of connected users 
To ensure you are viewing the latest information about open sessions on a computer, manually 
refresh the list of connected users. You must be able to access the computer and this open 
session.

Managing Devices
A device is any piece of equipment attached to a network, such as a computer, printer, modem, or 
any other peripheral equipment.

Although a device may be installed on your computer, Windows cannot recognize the device until 
you install and configure the appropriate driver. A device driver enables a specific piece of hardware 
to communicate with the operating system.

DRA enables you to configure and manage the devices only on the computers in the managed 
domains. The access account must have administrator permissions, such as being a member of the 
local Administrators group, on all computers where you want to manage devices. To assign these 
permissions, add the access account to the native Domain Admins group in the domain of the 
computer.

NOTE: You can manage devices only through the Delegation and Configuration Console.

Manage device properties 
You can modify the properties of a device on a specific computer. Modifying the device 
properties for a device allows you to modify the startup type for a device.

Start a device 
You can start a device on a specific computer in the managed domain or managed subtree.

Stop a device 
You can stop a device on a specific computer in the managed domain or managed subtree.

Managing Event Logs
An event is an important system or application occurrence. The Windows operating system records 
information about events in event log files. There may be several event logs stored on each 
computer. Use the native Windows Event Viewer to view event logs. DRA manages the event logs 
only on the computers in the managed domains. 

DRA records user-initiated operations in the log archive, a secure repository. You have the option to 
have DRA also record user-initiated operations in the Windows Event Log in addition to recording 
the information in the DRA log archive. For more information, see Understanding Dates and Times.

NOTE: You can manage event logs only through the Delegation and Configuration Console.
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Event Log Types
Computers running Microsoft Windows record additional information in various logs. The logs are 
briefly described as follows:

Event Log Management Tasks
You can specify the maximum size of an event log file and what happens to an event log when it 
becomes full. The properties window also displays the name of the log, the log file path and 
filename, when the log was created, when it was last modified, and when it was last accessed. If you 
choose to back up the log file, DRA saves the event log with a unique file name in a standard location 
on the selected computer.

DRA lets you manage event logs while managing other resources for that computer. With the 
appropriate powers, you can perform various share management tasks, such as changing event log 
properties.

Enable and disable Windows event log auditing for DRA 
When you install DRA, audit events are not logged in the Windows event log by default. You can 
enable this type of logging by modifying a registry key.

WARNING: Be careful when editing your Windows Registry. If there is an error in your Registry, 
your computer may become nonfunctional. If an error occurs, you can restore the Registry to its 
state when you last successfully started your computer. For more information, see the Help for 
the Windows Registry Editor.

Manage event log properties 
You can modify event log properties for a specific computer.

View event log entries 
You can view entries in a specific event log for a computer in the managed domain or managed 
subtree. When you view an event log, DRA launches the native Windows Event Viewer.

Log Type Description

ADAM Records events logged by the ADAM repository.

Application Records events logged by an application on the computer, such as a service 
startup or failure. For example, DRA stores events in the Application log.

Directory service Records events related to domain controllers maintaining the security 
database.

File replication service Records events related to file replication services provided by the operating 
system.

Security Records events that include logon attempts, file and directory access, and 
security policy changes that are based on the audit policy options.

System Records events logged by the Windows system components, such as the 
failure of a driver or services starting and stopping.
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Clear the event Log 
You can clear entries in a specific event log for a computer in the managed domain or managed 
subtree. You can also save the event log entries before clearing the log.

Managing Open Files
An open file is a connection to shared resources, such as files or pipes. A pipe is an inter-process 
communication mechanism that enables one process to communicate with another local or remote 
process.

DRA manages open files only on computers in the managed domain and managed subtree. Because 
open files are associated with a computer, you can manage open files while managing other 
resources for that computer. For example, you may want to close open files when you shut down a 
system or install a new device or service. You can also monitor which files users access most often, 
helping you better assess file security.

NOTE: You can manage open files only through the Delegation and Configuration Console.

Close a file 
You can close open files from resources on the network. It is a good idea to notify users when 
you intend to close open files. They may need time to save their data. To close an open file, you 
must be able to access the corresponding computer.

Refresh the list of open files 
To ensure you are viewing the latest information about open sessions on a computer, manually 
refresh the list of connected users. To refresh the open file list, you must be able to access the 
corresponding computer.
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8 8Managing the Recycle Bin

The Recycle Bin provides a safety net by allowing you to delete user accounts, groups, contacts, and 
computer accounts on a temporary basis. You can then restore these objects to their original state 
with all data, such as SIDs, ACLs, and group memberships intact or permanently delete these objects. 
This flexibility provides a safer way to manage user accounts, groups, contacts, and computer 
accounts. You can use the search option to search for required objects. For information, see 
Searching for Objects.

Restore an object from the Recycle Bin 
You can restore deleted objects back to the containers from which you deleted the objects. DRA 
restores these objects to their original state with all data, such as SIDs, ACLs, and group 
memberships intact. An object can be a user account, group, contact, dynamic group, resource 
mailbox, dynamic distribution group, or computer account.

Restore all Objects 
You can restore all objects from the Recycle Bin for a managed domain. You can restore objects 
from the Recycle Bin for a specific domain or across all managed domains. To restore objects 
from a Recycle Bin for a specific domain, the Recycle Bin must be enabled for that domain.

Delete an object from the Recycle Bin 
You can permanently delete objects from the Recycle Bin for a managed domain. Once you 
delete an object from the Recycle Bin, you cannot restore the object. An object can be a user 
account, group, contact, dynamic group, resource mailbox, dynamic distribution group, or 
computer account.

Empty the Recycle Bin 
You can empty the Recycle Bin for a managed domain. Emptying the Recycle Bin permanently 
deletes any objects currently in the Recycle Bin. You can empty the Recycle Bin for a specific 
domain or across all managed domains. To empty a Recycle Bin for a specific domain, the 
Recycle Bin must be enabled for that domain. Once you empty the Recycle Bin, you cannot 
restore the deleted objects.
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